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About this information product

Purpose The CentreVu IP (Internet Protocol) Agent Installation and User guide
includes information that you need to know in order to install and use
CentreVu IP Agent (IP Agent). It also includes a job aid that you can
refer to when starting to use IP Agent and information on performing
administrative tasks.

This guide does not provide information on how to use CentreVu IP
Agent as a telephone. Please refer to your agent training guide.

Reason for reissue  Thisisissue 1 of this document.
Safety labels  Thisis not applicable to this guide.

Intended audience  This guide is intended for anyone who is installing and/or using the
CentreMu |P Agent software and performing station administration on
the DEFINITY® ECS (Enterprise Communications Server). It assumes
that you are familiar with your computer and the Windows® 95,
Windows 98, Windows 2000, or Windows NT® 4.0 operating systems,
including standard Windows conventions, such as using the F1 key to
activate Help.

585-215-110 Lucent Technologies X i
Issue 1, March 2000



Conventions used

Related documentation

About this information product

The following Conventions are used in this document:

Convention
Initial Capital
Letters

KEY+KEY

Italic Text

Click and Double
click

Microsoft® Windows
or Windows

IP Agent

Description

Names of windows, dialog boxes, and
keyboard keys. For example, The Name field
is in the Properties dialog box.

Key combinations for which you must press
and hold down one key and then press
another key at the same time. For example,
Ctrl+F4 means that you press the Ctrl key
and F4 key at the same time.

References to other documents, trademarks,
and for emphasis.

Sections and chapters that are referenced. For
example, See “Chapter 2, Installing IP
Agent,” for information how to install the
software.

Whenever you are asked to click or double
click the mouse button, click button 1 (the
left-most mouse button or primary button),
unless button 2 (the right-most button or
secondary button) is specified.

These terms are used to refer to Windows 95,
Windows 98, Windows 2000, or Windows NT
4.0.

This term is used throughout the manual to
refer to CentreVu IP Agent.

There are many documents that can help you use the IP Agent
software. The most important documents are listed below:

*  CentreVu Call Management System Release 3 Version 6
Administration Volumes 1 and 2 (585-215-850)

*  DEFINITY Enterprise Communications Server Release 8.1
Administration and Feature Description Issue 4(555-230-522)

 DEFINITY Enterprise Communications Server Automatic Call
Distribution (ACD) Supervisor Instructions Issue 4(555-230-724)

DEFINITY Enterprise Communications Server Automatic Call
Distribution (ACD) Agent Instructions Issue 5(555-230-722)

Lucent Technologies
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1 | ntroduction

Overview

Purpose Introduction provides basic information about IP Agent and provides
preparation information that will assist you when installing the
application.

Introduction includes the following topics:
|About Centrevu® 1P Agent [1-2]|

e |[CentreVvu IP Agent Job Aid [1-9]|

585-215-110 Lucent Technologies 1-1
Issue 1, March 2000



Introduction

About CentreVu IP Agent

Introduction

IP Agent Features

IP Agent Main Window

The Lucent Technologies IP Agent software provides a solution for
agents like you who want to work remotely from their homes. In
order to work remotely, you need to have access to the switch features
that are used in the call center. IP Agent provides a graphical user
interface (GUI) to the DEFINITY® ECS, which lets you use the
DEFINITY ECS features that have been administered for your station.
You use IP Agent in conjunction with an analog phone for voice
connection.

Important! If you need to dial your emergency access number in an
emergency, hang up your 1P Agent voice phone and dial your access
number as you would normally dial it from a regular phone. Do not
use your I[P Agent phone in an emergency.

From the IP Agent window, you can:

* Make cdls.

*  Answer cals.

*  Place cadls on hold.

e Hang up cdls.

 Transfer cals.

*  Reconnect a held call.

»  Set up and manage conference calls.
*  Program speed dia buttons.

Set IPAgent to use call handling features such as Auto Call
back, Call Answer Back, Call Forwarding, Call Park, Call
Pickup, Send All Calls, Redirect, and Transfer to AUDIX. These
features must be administered on your extension by your
DEFINITY ECS system administrator.

*  Place cals from the Phone Directory or Call History dialog box.

The IP Agent application has been designed with your convenience in
mind. The main window is a single-view graphical user interface
(GUI) that incorporates buttons, pull-down menus, and a mouse.

The main window has a menu bar, toolbars, and panels. It also
includes an area in which you can record call information. You can
minimize or close this window.

Lucent Technologies 585-215-110
Issue 1, March 2000



About CentreVu IP Agent

Introduction

All window sizes and open dialogs are saved on exiting the window.
When you open the main window the next time, it will look exactly
the same as it did when you closed it, including the same location,
size, and open dialogs.

The main window looks like this:

_ ¥ CentreVu IP Agent - 47770 - (Agent 46720) = B3

_ e Lol e dew gpad Lods Sefiime delr
/ ?( §%|%l Vs Qﬂ” Number:l T s
\\.

etedm a0

Call Informaticn

n| 000008 || Ausiiary Work Mode | |

Panel |_

| Phone Display |— |

Status Bar | Fleady A

The main window contains the following components:

Title Bar: Contains the application name followed by the
extension of the phone (for example, CentreVu IP Agent -
47770). If you have logged in, your agent ID will also be
included on the title bar (for example, [Agent 46720]).

In the above example, the agent is logged and is in Auxiliary
Work Mode (not on a call). If he or she were on a cal, the string
on the title would contain the same information displayed on the
Cdll Information Panel (CIP).

Menu Bar: Contains a row of menu options, any of which you
may select to display a menu.

Toolbars: Contain a row of buttons used to activate various
functions of the IP Agent application. The IP Agent main window
can contain as many as five toolbars.

Call Information Panel (CIP): Provides information about a single
cal, such as name, call duration, status icon, and control buttons
(for example, Answer/Release and Reconnect).

Phone Display: Receives information from the DEFINITY ECS
such as user-entry prompts, call prompting digits, and VuStats
data.

Status Bar: Displays IP Agent application status and tooltips.

585-215-110
Issue 1, March 2000

Lucent Technologies 1-3



About CentreVu IP Agent

Toolbars

Introduction

The following toolbars are associated with the IP Agent main
window—Phone Button, Dial Number, Agent, and Headset. These
toolbars contain buttons that you can use for quick access to specific

commands and tools.

Examples of the toolbars containing callouts of the names of each
button are shown below. For more information on the toolbars, see

[Displaying Toolbars and Dial Pad [6-11]

Phone Button Toolbar

Release —| ?( ﬂq;. | % | E&ﬂ | ﬁq} Conference
| |
Crop Transfer
Held
Dial Number Toolbar
Mumber: @||v |§|7

| |

Dizl Murmber Call History
Phone Directory

Agent Toolbar

b

ﬁ — Assist

Agent Leagin

R A

Agent Logout

Bmihary 'Work Mode

Atter CallWerk

Aute n lode

Mznuzl In ode
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Supported Phone Sets

585-215-110
Issue 1, March 2000

Introduction

Headset Toolbar

[

Teggle Headset

Here is a list of phone sets that Lucent Technologies supports for use
with IP Agent. You may use other phone sets; however, phone sets
other than those on the following list may not function correctly and
are not supported by Lucent Technologies.

«  CALLMASTER® II—602A1

« CALLMASTER I11—603A1, 603D1, and 603E1
« CALLMASTER—G603F1

« CALLMASTER V—607A1

« CALLMASTER VI—606A1

e 6408D+

e 6408D

e  6416D+

e 6416D+ with expansion module
e 6424D+

e 6424D+ with expansion module
e  8405D+

e  8405D

e 8410D

e 8411D (For this phone set, you have to disable the data port,
which is true for all softphones.)

e 8434D
e 8434D with expansion module

Lucent Technologies 1-5



About CentreVu IP Agent Introduction

Supported International  This table shows which language versions of 1P Agent are supported
Versions of IP Agent  with which Windows®™ operating systems. (The symbol X indicates
that the operating system is supported). This table is divided into Part

1 and
CentreVu IP Agent Languages - Part 1
Windows a =
Operating = ] -
System = - = I:::ﬂg = J'.E:l P E
A2 = o = = =g
= [ £ E - c =2 % 5
£ " o @ o = ap2 gE
m = I T o @ w So
Wing5 X X X X X X
@ Wingg X X X X X X
2
w | Win2000 X X X X X X
WinNT X X X X X X
Wings X X
c Wingg X X X
=
= | winzo00 X X
WinNT X X X X X X
Wings X X
£ Wings X X
g
o
| Win2000 X X
WinNT X X
Wings X X
B Winog X X
=
& | winzooo X X
WinNT X X
1-6 Lucent Technologies 585-215-110
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About CentreVu IP Agent Introduction

This is Part 2 of the CentreVu 1P Agent Languages table.

CentreVu IP Agent Languages - Part 2
Windows v E
Operating = L] @
| B =
System = - £ = = B E E m
[— = c E & - =] ® B
2 | 5 5 s | 55 | 83 | &8
u = i (] o @ Wl Zo
Wingd X X
i
@ Winga X X
=]
:: r
| win2000 X X
o
WinNT X X
Winas X X
i Wingg X X
E
[
o | win2000 X X
WinNT X X
Wings X X
& r
v Wingg x x
&
=] Wirn2000 X X
Lo
WinNT X X

Installation Support and If you have difficulty installing IP Agent, refer to the following
Tips  sources:

»  System requirements specified in What You Need on Your
Computer [2-2].

. The readme.txt file on the CD-ROM. Use an editor such as
Windows Notepad to read the file.

If you have further questions, contact the Lucent Technologies
National Customer Care Center on 1-800-242-2121. For international
support, call your Lucent representative or distributor for assistance.

585-215-110 Lucent Technologies 1-7
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About CentreVu IP Agent

CentreVu IP Agent
Package Contents

US English Only IP Agent
Components

Introduction

The CD-ROM in your package includes a graphical installer to help
you install your copy of IP Agent. The CD-ROM aso supports
Windows AutoPlay. If AutoPlay is enabled on the PC, insert the
CD-ROM into the drive and the CentreVu 1P Agent Install program
starts automatically.

You can cancel the installation at any time by selecting Close from
the control menu or pressing Alt+F4. You can also cancel the
installation by selecting the Cancel button at the bottom right of the
installation window. The installation program will exit installation and
remove any files that were built by the program.

The CentreVu 1P Agent software package includes a CD-ROM that
contains the 1P Agent software and folders that contain material such
as documents and tools. Read the readme.txt file in each folder for
more information about the contents of the folder. The documents
contained in the documents folder are Portable Document Format
(PDF) documents. Adobe Acrobat Reader 3.0 is required to view PDF
documents.

The following IP Agent components are only provided in the English
language:

* Installation

 Help About Screen

« Event log

 |PAgent interna files

e Shortcut keys for secondary callbars
* Readme file

Lucent Technologies 585-215-110
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Introduction

CentreVu IP Agent Job Aid

Quick Reference

Using Shortcut Keys

Use this job aid to quickly begin using IP Agent.

1.

To log into 1P Agent, double click on the CentreVu 1P Agent
icon.

Enter your virtual Extension and Password on the DEFINITY®
Login window. You need your IP Address or host name and the
call back number for the voice connection.

Click the Log In button.

If IP Agent doesn't log in, select File and then select DEFINITY
Login in the CentreVu IP Agent window.

To log in as an agent, first make sure the phone next to your
computer is hung up. Click the gold key (Agent Login button) or
press Ctrl+Insert. Enter your Agent ID and Password, and then
press the Enter key.

The phone next to your computer rings. Answer the call and you
will hear the confirmation tone. The Agent buttons on the
CentreVu IP Agent window light up.

To start taking calls, click the Auto-In button (gold phone with
arrow) or press Ctrl+l.

To take your break, click the arrow associated with the AUX
button (blue cup), and select the reason code, if appropriate.

To log out, click the Agent Logout button (gold key with arrow)
and enter the logoff reason number code, if appropriate.

Shortcut keys refer to key combinations, such as Ctrl+H, that you can
use to invoke a particular command.

Call Features

Some of the most commonly used shortcut keys are discussed below.

1.

To put a call on hold, press Ctrl+H. To reconnect to the caller,
click the Reconnect button or press the space bar.

To transfer a call, press Ctrl+T, and then dial the number using
the keyboard. When you are ready to complete the transfer, press
Ctrl+T again.

To conference another person into the call, press Ctrl+F, and then
dial the number using the keyboard. When ready to add the new
person to the call, press Ctrl+F again.

585-215-110
Issue 1, March 2000
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CentreVu IP Agent Job Aid

Introduction

Toggling Between Applications

To toggle between applications, press Alt+Tab until the desired
application is showing.

Calling the Help Desk

To call the Help desk, press Ctrl+T, and dial xxxx. If you want to
transfer the call to the Help desk, press Ctrl+T again. Otherwise, click
the Release button to release the call to the Help desk; then click the
Reconnect button to reconnect to the held call.

Exiting IP Agent

To exit IP Agent, first log off as an agent, then click the small x in
the top right corner of the IP agent window. Then right-click the
phone in the tool bar at the bottom right corner of your screen. Select
“Log off & exit DEFINITY Login.”

O

Lucent Technologies 585-215-110
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2 Installing IP Agent

Overview

Purpose Installing IP Agent explains how to install the IP Agent on your
computer from the CD-ROM or the network.

The following topics are included:

« [Before You Begin [2-2]|

« |Installing from the CD-ROM [2-3]|
« |Installing from the Network [2-13]|

585-215-110 Lucent Technologies 2-1
Issue 1, March 2000



Before You Begin

Installing 1P Agent

Introduction  Before You Begin provides the tasks you need to perform and the
information you need to know before installing IP Agent.

Methods of Installation  There are two methods you can use to install the IP Agent application
on your computer:

CD-ROM Installation—installing the application onto your
computer from the CD-ROM.

Network Installation—installing the application onto your
computer from a network. This is a two-step process that consists
of copying the installation program to the network and then
installing across the network onto your computer.

What You Need on Your A computer running CentreVu® |P Agent software must meet the
Computer  minimum recommended requirements listed below.

Hardware Requirements

Your computer must meet or exceed the following configuration:

Intel Corporation Pentium® Il processor, 200 MHz or greater
32 megabytes of RAM

SVGA with 640x480 resolution or higher

28.8K Modem for the remote IP connection

CD-ROM drive

Software Requirements

Your computer has to be running one of these operating systems:

«  Wndows® 95
Windows 98
«  Wndows NT® with Service Pack 4
*  Windows 2000
]
2.2 Lucent Technologies 585-215-110
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Installing from the CD-ROM

Introduction

Procedures

The CentreVu IP Agent CD-ROM supports the Windows A utoPlay
feature. If AutoPlay is enabled on the PC, insert the CD-ROM into the
drive, and the IP Agent Setup program will start automatically.

See your system administrator for information on how to enable or
disable AutoPlay on your PC.

To install 1P Agent from a CD-ROM, do the following:

Before starting the installation, close all running programs on the
computer. If you do not close al running programs, a warning may
appear asking you to reboot your computer.

If AutoPlay has started, go to[Step 6. If you are not using AutoPlay,
continue with Step 4.

Click Start on the taskbar and select Run.
Result:
The Run dialog box appears.

In the Open text box, enter the drive you are installing IP Agent from,
followed by \setup (for example, f:\setup), and then select OK.

Result:

A setup message appears informing you that IP Agent is
preparing the wizard that will guide you through the setup
process.

585-215-110
Issue 1, March 2000
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Installing from the CD-ROM Installing IP Agent

6 The splash screen appears briefly.

Lucent Technologies

EBell Labs Ennovations

CentrevVu®
IP Agent

Copyright & 19992000 Lucerd Techrologies. A1 rights recerved

Result:

Next, the Welcome window appears.

Welcome

whelcome to the Centretu 1P Agent Setup program.
Thiz program will install Centret/u [P Agent an your
computer,

It iz gtrongly recommended that you exit all Windows programs
befare running this Setup program.

Click Cancel to quit Setup and then cloze any programs you
have running.  Click Mest to continue with the Setup program.

WARMIMG: This program iz protected by copyright law and
international treaties.

Unautharized repraduction ar distribution of this program, or any
portion of it, may rezult in severe civil and criminal penalties, and
will be prosecuted to the marximum extent poszible under law.

Cancel

2-4 Lucent Technologies 585-215-110
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Installing from the CD-ROM Installing IP Agent

7 Sedlect Next to continue with the installation.
Result:

The Software License Agreement dialog box appears.

Software Licenze Agreement E2

Fleaze read the follmwing License Agreement. Press the PAGE DOWHM key to see
the rest of the agreement.

|- Licensze - =]
|dnder thig license pou

- Uze thiz CD an only ohe machine at any time;

- Make a backup copy af thiz CD;

- Transfer poszession of this CD to anather party along with a copy of this icense and all —
rightz to the original unalkered copy of the zoftware and documentation,

|dnder thig license pou may not;

- Uze, copy, modify or transfer copies of this CD, except az provided in this license:

- Alter, modify, or adapt this CD offer, including but not limited ta translating, decompiling,
dizaszembling, reverse engineering, or creating derivative works;

- 1ewerze agzemble o reversze compile thiz CO offer; or

- sublicense, rent, lease, sell, or aszign this CO for monetary consideration.

hd|
Do you accept all the terms of the preceding License Agreement’y [f you chooge Mo, Setup
will close. Tainstall Centreliu [P Agent, you must accept thiz agreemeant.

< Back Yes Ho |

8 Select Yes to accept all the terms of the License Agreement, or No to
exit the installation.

585-215-110 Lucent Technologies 2-5
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Installing from the CD-ROM Installing IP Agent

Result:

If you select Yes, the Choose Destination Location dialog box
appears.

Choose Destination Location

Setup will install Centretu 1P Agent in the following folder.
Toinztall to this falder, clhick Hest.

Toinztall to 5 different folder, click Browse and select another
folder.

'ou can chooze not bo ingtall Centrebu [P dgent by clicking
Cancel to exit Setup.

Destination Folder
(E:'\...'\Lucent'\[lentre\n‘u IP &gent Browse... |
< Back Cancel |

9 In the Choose Destination Location dialog box, choose one of the
following:

e If you want to install the software in the default destination
folder, select Next, and go to[Step 11

* |If you want to select a different destination folder in which to
install the software, click Browse.

Result:

The Choose Folder dialog box appears.

10 In the Choose Folder dialog box, select the destination folder you
want and click OK.
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11

12

13

14

Result:

The Setup Type dialog box appears.

Setup Type

Click the type of Setup you prefer, then click. Mest.

inztall additional language versions.

& Tunica Program will install the most common optionz.
................. t This vl inclucdes
Centrebfu [P Agent - Englizh
Centre¥u IF Agent Help - English
= Custom Y'ou may chooge the options pou want to install

Lze this option to zelect additional language
verzions o ingtall. “ou may run zetup again bo

Installing IP Agent

< Back I Hewt » I

Cancel

In the Setup Type dialog box, select the type of installation and click

Next.

*  Typical—this selection will install al of the basic options in
English, which is required, as well as all of the basic options in
the language of your supported Windows operating system.

e Custom—this selection lets you choose which options and

language versions to install.

Before making your selections, read the bottom half of the dialog box.

It provides the following information:
»  The space required for each component
* The total space available on the specified drive

585-215-110
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15

16

17

18

Installing 1P Agent

Important! See[Supported International Versions of IP Agent [1-6]| for
more information about which languages are supported with which
version or operating system of 1P Agent.

Select Next.
Result:

The Select Program Shortcuts dialog box appears.

Select Program Shortcuts E

¥ Add shortcuts to the Windows Desktop.
[ Add shortcuts ko the Start Menu,

Select the language(s] pou would like to have added:

Centreliu IP Agent - English

[ utamatically start the following version of Centret/u
#gent when Windows is started:

IEentreVu IP Agent - English ﬂ

< Back I Ment » I Cancel |

Indicate whether or not you want IP Agent shortcuts by clicking any
of the following:

e Add shortcuts to the Windows desktop.
e Add shortcuts to the Start Menu.

In the list of languages box, highlight the language you want to be
used for the program shortcuts. For example, in the Select Program
Shortcuts dialog box above, “CentreVu IP Agent — English” is
highlighted.

Lucent Technologies 585-215-110
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Important! If you click a shortcut box but do not select a language, a
warning appears telling you to pick at least one language.

19 Indicate whether you want to automatically start CentreVu IP Agent
when Windows is started (checked by default).

Important! If you are using a dial-up modem with a dynamic IP
(Internet Protocol) address, do not start IP Agent at Windows startup.

20 Select Next.
Result:

The Start Copying Files dialog box appears. This dialog box
displays the setup options that you have chosen.

Start Copying Files E2

Setup has enough information to gtart copying the program files.
If you want to review or change any settings, click Back. If you
are satisfied with the settings, click Mext to begin copping files,

Current Settings:

Program Folder: C:A\Program FilesiLucent\Centrel/u [P Agent =
Setup Tepe: Typical

Components Selected:
Centret/u [P Agent - English

Proaram Group Folder:
Lucent Centrebfu [P Agent

Degktop Shorbcut(z]:

Centret/u [P Agent - English -
1| | v
Cancel |

< Back

21 If you are satisfied with the setup options, select Next.
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Result:

The Completion Status dialog box displays the components and
files that are being copied.

Centre¥u Agent Completion Status

¥ Setup Spstem Fonts...

¥ Updated Windows Registry. ..
Setup Telephone Service Provider...
Setup Centrevu Agent Program Folder...

Setup CentreYu Agent desktop shortcuts, .

22  The Lucent Configurator dialog box appears. Select OK.

Result:
The Microsoft Common Controls dialog box appears.

Lucent Centre¥u IP Agent Setup - Question ]

@ IP Agent setup now needs to install the Microsoft Comman Controls. Do pou wish to continue?

23 You must install the Microsoft Corp. Microsoft® DLLs which are
needed to run IP Agent. Select Yes to continue.

24 In the Microsoft COMCTL32.DLL Update screen that appears, select
Yes to install the DLL update.

Lucent Technologies 585-215-110
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Installing IP Agent

25  The Microsoft license agreement appears. Select Yes if you want to
accept the terms of the license agreement.
Result:
The Microsoft DLL update has been installed. Select OK to
continue.
26 You are asked if you want to restart your computer. Select Yes.
Microsoft COMCTL32.DLL Update
@ 'ou must restart pour computer before the new settings will take effect.
Do wou want to regtart pour computer now?
Ma
Important! Selecting Yes does not mean that your computer will be
automatically restarted at this time. You will need to restart it when
you compl ete the setup.
27  After the files have been copied, the Setup Complete dialog box
appears.
585-215-110 Lucent Technologies 2-11
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Result:

Setup Complete

Setup has finizhed copying files to your computer.

Befare you can use the program, you muzt restart Windows or
your computer.

% Mes | warl bo restart my compber now

€ Mo, | will restart my computer |ater,

Remove any dizks from their drives, and then click Finish to
complete setup.

28  Click Finish to complete the setup, and restart your computer.
END OF STEPS
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Installing from the Network

Introduction

Setting Up the Network

585-215-110
Issue 1, March 2000

Use these procedures to copy the IP Agent installation program onto a
Local Area Network (LAN), and then install the program across the
network onto your personal computer.

To set up the network, do the following:

At a computer that is connected to the network, insert the CentreVu IP
Agent CD-ROM into the CD-ROM drive.

Important! If AutoPlay is enabled on the PC, the IP Agent Setup
program will start automatically after you insert the CD-ROM into the
drive. In this case, cancel the auto-install by clicking the Cancel
button in the setup window that displays.

Create a folder on the network drive, and record the path to the folder
for later use.

Set your Windows Explorer options to “Show all files.” In Explorer,
select View. Then select Options and click Show all files.

Using the Copy command or drag-and-drop, copy the contents of the
CD-ROM to the folder you created in Step 4. Be sure to copy all of
the files.

Verify that the network where you copied the contents of the
distribution medium is available to each computer that will be
installing 1P Agent from the network.

Go to|Setting Up the Computer [2-14].|

END OF STEPS
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Setting Up the Computer

Installing 1P Agent

To install 1P Agent on each computer from the network, do the
following:

Before starting the installation, close all running programs on the
compulter.

In Windows Explorer, go to the drive and then the folder containing
the CentreVu IP Agent files.

Important! You may want to map the network drive containing the IP
Agent folder to your computer.

Locate and double click the setup.exe file to begin the installation.

Additional accessory files that reside on the CD-ROM, athough
copied to the network drive, will not be installed on the computer.

If you want to follow a step-by-step description of the installation, go
to Installing from the CD-ROM [2-3] |

END OF STEPS
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3 Uninstalling IP Agent

Overview

Purpose  You can easily uninstall the IP Agent application using the Microsoft®
Windows® Add/Remove Programs wizard. Uninstall removes the IP
Agent files (al installed languages), the folders, and the PassageWay
Telephony Service Provider from the computer. Read-only folders that
are shared with other applications are not removed.

Performing the Uninstall [3-2] explains how to perform an IP Agent
uninstall from a network server or a stand-alone PC.
O
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Performing the Uninstall

Procedures

To uninstall the IP Agent application, do the following:

From the Control Panel, double-click the Add/Remove Programs icon.
The Add/Remove Program Properties box appears.

Click the Lucent CentreVu IP Agent entry in the list of software that
can automatically be removed by Windows.

Click the Add/Remove... button.
Result:

The Confirm File Deletion message box appears.

Confirm File Deletion B4 |

@ Are you sure pou want bo completely remove Lucent Centrebdu [P Agent’ and all of its components’?

Select Yes to remove the CentreVu IP Agent application.
Result:

The uninstall Shield wizard begins and the Remove Programs
From Your Computer dialog box appears. The Uninstall program
enters a check by each component after it is removed.

Lucent Technologies 585-215-110
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7  Whenever the uninstall program encounters a shared file that is no
longer shared by a program, you are asked whether you want to
remove the shared file.

Select one of the following options:

*  Yes—deletes the shared file

* YesTo All—deletes all remaining shared files

*  No—does not delete the shared file

* No to All—does not delete the remaining shared files

Important! If you selected Yes or No, the uninstall program continues
to display the Remove Shared File? dialog box every time it
encounters a shared file.

585-215-110 Lucent Technologies 3-3
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Result:

When the uninstall is complete, the message “Uninstall
successfully completed” appears at the bottom of the Remove
Programs From Your Computer dialog box.

Remove Programs From Your Computer |

unlngtallShield will remowve the software 'Lucent Centretu 1P
Agent' from pour computer. Pleaze wait while each of the
following components iz removed. ..

Shared program files. .
Standard program files...
Folder iternz. .

Frogram folders. .

Frogram directaries...

T S O Y

Frogram reqiztny entries. .

Uninztall succeszfully completed.

Ok,

9 Restart your computer.

Important! You must restart your computer before you can reinstall
IP Agent. Otherwise, you will get a message telling you to restart your
computer.

END OF STEPS
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4 Running and Exiting IP Agent

Overview

Purpose

585-215-110
Issue 1, March 2000

Before you can use IP Agent as a telephone, you need to first
establish connectivity to your company’s LAN (Loca Area Network)
where the DEFINITY® ECS resides. Then you need to register your
extension with the DEFINITY ECS by completing the DEFINITY®
Login window.

After you are registered with the DEFINITY ECS, you have an
operating telephone and can now make, receive, conference, and
transfer calls. However, in order to make yourself available for ACD
calls, you need to perform an Agent login.

Running and Exiting IP Agent explains how to perform all of the
above tasks, including:

e [Starting IP Agent [4-2]|

« [Logging into the DEFINITY ECS [4-3]]
« |Logging into Agent Mode [4-8]|

« [Exiting IP Agent [4-11]]

Lucent Technologies 4-1
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Starting IP Agent

Procedure To run IP Agent, do the following:

5 Select CentreVu IP Agent in the language you prefer from the menu.

Result:

The CentreVu IP Agent and the DEFINITY Login windows
appear. Although IP Agent is now running, you are not yet
logged into the DEFINITY server.

¥ Centre¥u IP Agent - Not Logged In M= B
File Edit “iew Agent Toolz Sething: Help

v Q’Hﬁ. e Numl::er:[| T
&4 | & eo- U0

Ready i

6 Go tolLogaing into the DEFINITY ECS [4-3] |

END OF STEPS
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Logging into the DEFINITY ECS

Introduction  Before you can use IP Agent, you need to log on to the DEFINITY
ECS.

Procedure To log into the DEFINITYECS, follow these steps:

1 When you open IP Agent, the DEFINITY® Login window
automatically opens. If the Login window does not open, select File
and then select DEFINITY Login from the IP Agent window.

585-215-110 Lucent Technologies 4-3
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Result:
The DEFINITY® Login screen appears.

=E DEFINITY® Login !IEIE

— Login Information

Estension: [e.g. BE5E] LUEEHtO

Paszword:

[T Bemember pazzword for next login

SEVer (™ DEFINITY Mode Name [

& |P Address _ I _ I _ I

— Call Contral &pplication

Centretfu IP Agent - Englizh

—Yoice Connection

Telephone at: [| -

B I Cancel | Help About ..

2 Inthe Extension box, enter the assigned extension that you will
assume on the DEFINITY ECS.

4  To save your password for the next time you log into the DEFINITY
ECS, enable the “Remember password for next login” check box.
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5 Inthe Server area, do one of the following:

* Click the DEFINITY Node Name option button, and enter the
domain name for the DEFINITY ECS.

*  Click the IP address option button, and enter the IP address for
the DEFINITY ECS.

6 Inthe “Telephone at” box, enter the phone number you will be using
for talking and listening.

Important! You must enter the “ Telephone at” phone number in the
correct format for the DEFINITY ECS to dia it. This is the number
that the server calls to reach you. Remember that the server may need
to dial 9 to access your location.

585-215-110 Lucent Technologies 4-5
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Result:

Here is an example of a completed DEFINITY® Login screen.

=B DEFIMITY® Login !IEIE

— Login Information
Lucento

Extenzion: |Gyl

Paszward: Imx

W Bemember pazzword for next login

SEMVEL & DEFINITY Nods Mame  [135.9.190.140 |

= |P Address : I : I : I

— Call Control &pplication

Centretfu IP Agent - Englizh

—Waice Caonnection

Telephane at | 9303 555 5555 |

Log In Cancel | Help | About .

7  Click the Log In button. The Verify Telephone Number window
appears.
Important! As suggested in this window, it is very important that you

make some test calls before logging in as an agent, to verify that you
have set up your connection properly.

8 Click OK to continue.
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Result:

The Login icon in the IP Agent main window is highlighted.
This means that you have successfully logged into the
DEFINITY ECS.

B CentreVu IP Agent - 47770 M= E3

File Edit “iew Agent Toolz Setting: Help

X Qﬂﬁ. Lbﬂﬁ:? Numl:uer:l] T R
SARIE AT 2 RS

Ready o

The “Not Logged In” phrase in the CentreVu IP Agent title bar
has been replaced by your assigned extension and the
DEFINITY® Login screen displays your login status.

9 Go tolLogging into Agent Mode [4-8].|
END OF STEPS
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Logging into Agent Mode

Introduction  The CentreVu® IP Agent login is for EAS (Expert Agent Selection)
agents only. If you are an EAS agent, you will need to log into agent
mode in order to receive ACD (Automatic Call Distribution) calls.
Agent mode means that you log into the skill set associated with your
EAS agent number, which makes the Agent toolbar available for your
use.

If you are a non-EAS agent, you will need to use the phone feature
buttons instead of the Agent toolbar, or dia the desired FAC (Feature
Access Code) as you would on a regular agent telephone set. (See
[Administering Options [7-5]| for ways to efficiently handle your phone
feature buttons, such as organizing and renaming them.) Ask your
DEFINITY ECS administrator to configure your DEFINITY extension
to include autodial buttons for each of your agent splits; for example,
Agent Log In, Agent Log Out, and Auto-In mode.

Procedure To log into agent mode, use the following procedures:

1 Inthe CentreVu IP Agent window, click the EAS Agent Login button

(highlighted).
¥ Centrevu IP Agent - 47770 ME B3
File Edit “iew Agent Tools Settings Help
x Q@‘ % ﬁbﬁ ﬁ;)” Murnber: || @ - 24 -
S| £ 5|0
Ready i
4-8 Lucent Technologies 585-215-110

Issue 1, March 2000



Logging into Agent Mode Running and Exiting IP Agent

Result:

The Agent Login dialog box appears.

Agentlogn ______HJ

Pleaze enter your agent number and paszword.

Agent |4ET-"2EI
Paszwiard I“““ﬂ

Login Cancel |

2 Inthe Agent Login dialog box, enter your Agent number and
Password.

3 Click Login. As soon as you click Login, your voice phone rings.

Important! If you do not answer your phone immediately or if you
entered the wrong number for the voice connection, the following
message will appear: “Your cal could not be completed. Please try
again.” You will have to click OK and log in again.

4 Depending on how your DEFINITY ECS is administered, you will be
allowed to do either of the following:

»  After you have answered the initia call, leave your phone off
hook, and your phone line will stay open. This setting is called
“permanent.”

e  After you have answered the initial call, hang up, leaving your
phone on hook. This means that each time a call is received or
made, your phone will ring. This setting is called “as needed.”
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Issue 1, March 2000



Logging into Agent Mode Running and Exiting 1P Agent

Result:

The buttons on the Agent toolbar are highlighted, and the title
bar displays the Agent number. When you log in, you are
automatically placed in AUX (Auxiliary) work mode.

W CentreVu IP Agent - 47770 - [Agent 46720) M= E
Fil=e Edit Cal “iew pgent Toolz: Settings Help

XQ’%|% & G Number:l—@-lﬁ-

& %8 & wlel|zC
" 0001:33 || Ausiiany Work Mode | |
Ready s

5 To get out of AUX work mode, click either the Auto-In or Manual-In
button.

For more information about Auto-In and Manual-1n work modes, see
[Selecting Your Work Mode [5-2] .

6 You are now ready to begin receiving and making calls.
END OF STEPS
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Exiting IP Agent

Procedure This procedure tells you how to exit IP Agent and log out of
DEFINITY.

1 If you logged into agent mode, you need to log out. To log out of
agent mode, click the Logout button.

¥ CentreVu IP Agent - 47770 - (Agent 46720) M= E3
File Edit Cal Yiew pAgent Toolz Setting:  Help

XQ’*|%‘ GE Gy Number:l—@vﬁ-
|8 dwlelac

[ 0001:33 || Awiary Work Mods | |

Ready &

2  Depending on your DEFINITY ECS administration, you may be
required to enter a reason code. See|Using Reason Codes [6-19] |

4 Use your right-mouse button to click on the IP Agent icon on the right
side of your Windows® task bar.

Result:
The DEFINITY log off options are displayed.
Login status

Log aff & exit DEFIMNITYY Login
Log off & return to DEFIMITY Login

Help
Ahout DEFINITY Login ...
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5 Select one of the following DEFINITY log off options:
* Log off & exit DEFINITY Login.
* Log off & return to DEFINITY Login.

END OF STEPS
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5 Getting Started

Overview
Purpose  Getting Sarted is designed to quickly introduce you to IP Agent. In
just a short time you will be familiar with the following:
« |Handling Incoming Calls [5-2]]
« |Transferring a Call [5-7]|
« |Using Conferencing [5-12]|
« [Handling Outgoing Calls [5-18]|
e [Speeding-Up Outgoing Calls [5-21]|
« |Using the Phone Directory [5-25]|
 [Using the Call History Log [5-31]]
Throughout this section, you are instructed to click buttons to perform
commands or open dialog boxes (for example, “Click the Hold button
on the Phone Button toolbar.”) Most of these commands and dialog
boxes can also be accessed by selecting the option in the CentreVu IP
Agent menu bar. The options available on the P Agent menu bar are
discussed in detail in|Learning the Main Window [6-2] |
O
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Handling Incoming Calls

Introduction

Selecting Your Work Mode

Answering a Call

Handling Incoming Calls describes those functions that you will be
using every day when you receive an incoming call at your station,
including answering a call, holding a call, releasing a call, and
transferring a call. The following functions must be administered on
the DEFINITY® ECS for your station in order to work. See
[Administering Options [7-5]| for more information.

You can elect to set your incoming calls for Auto-In mode or
Manual-In mode by selecting the mode in the Agent toolbar. If you
are in Auto-In mode, when you complete a call, you are automatically
available to receive another call, or you may be placed in After Call
Work (ACW) mode for an administered length of time. When the
timed ACW interval expires, you are automatically returned to the
Auto-In mode. If you try to change agent modes while active on a
call, the change is not made until you disconnect from the call.

If you are in Manual-In mode, when you complete a call, you are
automatically placed in After Call Work (ACW) mode. In order to
become available to receive another ACD call, you must manually
enter the Auto-In or Manual-In mode. If you try to change agent
modes while not active on a call, the change takes place immediately.

Answering a call depends on how the DEFINITY ECS and network is
administered. Each Call Center environment is different, which can
affect the way you answer calls. It is suggested that each Call Center
evaluate its configuration and instruct the agent on the best way to
answer the IP Agent phone. There are too many possible IP Agent
configurations for Lucent to support al of them. Below are suggested
procedures on answering calls for two specific configurations.

Configuration 1

Agent administration for Auto Answer is set to station or none.
Station Administration for Auto Answer is set to none. Station
Administration has service link set to "as-needed.”

Each time a call is received, the analog phone set that provides the
voice path will ring, as will the computer, depending upon the IP
Agent option settings.
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Holding a Call

Getting Started

To answer a call for this configuration:

1.

Wait for the analog phone to ring and answer it. Answering the
analog phone will automatically answer the call on the IP Agent
screen. If there is another call ringing on the screen, do not hang
up the analog phone, click the answer button on the IP Agent
screen and you are now connected to this call.

After the calling party disconnects from the call or you click
release for that call, hang up the analog phone if no more calls
are ringing on the IP Agent screen.

If there is another call ringing on the screen, do not hang up the
analog phone. Click the answer button on the IP Agent screen
and you are now connected to this call.

Configuration 2

Agent administration for Auto Answer is set to station, ACD, or all.
Station Administration for Auto Answer is set to ACD or al. Station
Administration has the service link set to "permanent.”

During the event of Agent login, your analog phone will ring to
deliver the login confirmation tone.

To answer a call for this configuration:

1.

You should answer the phone and not hang it up for the
remainder of your Agent shift.

If the phone accidentally gets cut off or hung up, the DEFINITY
ECS will ring the analog phone when it has a call to deliver. You
will then need to answer the analog phone.

As with any auto answer phone, the DEFINITY ECS will provide
a zip tone (a beep) signaling that a new call has arrived .

You can put a call on hold by using either the Auto Hold or
Manual Hold feature.

To manually put a call on hold, click the Hold button on the Phone
Button toolbar.
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L"- Jonez, Bob
File Edit Call

Yiew Agent

Getting Started

Result:

The button on your CIP changes to Reconnect.

51500

Toolz

= B3

Setting:  Help

R G

g, e gy

= I

Mumber:

£ X s -

2

£

“ 0 0021

a=lonez, Bob

Reconnect

51500

Ready

Releasing a Call

You can manually answer a second call while on an active call
without having to put the first call on hold. The first call will
automatically be put on hold when you answer the second call
regardless of whether the Auto Hold or Manual Hold feature is
administered for your station.

END OF STEPS

There are three methods you can use to release a call. These
methods will work only if the release feature has been
administered for your station.

To release a call, do one of the following:

«  While on an active call, click the Release button located on the
CIP. You will not hear a dia tone after you press Release.

. Click the Release button located on the Phone Button toolbar.
*  Press the space bar on your keyboard.

If you have a call on hold, you must first reconnect it before you can
release the call.
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Example:

In the example below, you would have to reconnect call 51500
before you could release it.

¥ Smith, John

File Edit Call “iew Agent Toolz Settings Help

}( ﬂ?}|%[{}ﬂ§¢ Murmber: I R
Lelesdma-|ao

“ 00:00:21 || a=Jones, Bob 51500 i Reconnect
n 00:00:26 || b=5Smith, John il 35l Releaze
Heady i

END OF STEPS
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Dropping a Call  Use the Drop feature when you want to disconnect from a normal
call or drop the last party added to a conference call.

1 Todrop acal, click the Drop button located on the Phone Button
toolbar.

2 You are disconnected from the call and hear a dial tone.
END OF STEPS
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Introduction

Basic Transfer
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Getting Started

Transferring a Call describes the following three methods of
transferring calls:

* Basic Transfer lets you send the present call to another extension
or outside number. You select Transfer, dia the number,
announce the call, and select Transfer again.

*  Unsupervised Transfer differs from a Basic Transfer in that you
select Transfer, type the number to be caled into a text box, and
click OK to transfer the call. You do not announce the call.

»  Enhanced Transfer differs from a Basic Transfer in that you
select Transfer, type the number to be caled into a text box, and
click OK. After announcing the call, you can either click Yes to
transfer or No to not transfer the call.

Tip: The Transfer button can be configured for basic, unsupervised, or
enhanced transfer in the Options dialog box. However, you can choose
a type of transfer different than that configured by selecting the Call
menu and then selecting Transfer.

For more information on the Options dialog box, seeAdministering
[Options [7-5] |

To transfer a call using Basic Transfer, follow these steps:

While you are active on a call, select Call from the menu bar. Then
select Transfer and Basic Transfer.

¥ CentreVu IP Agent - 47770 - [Agent 46720] [ [ x]
File  Edit m Wiew Agent Toolz  Sefttings Help
?‘(_ Q: Release umber; I—_@ - 28 -

I =

Hold Chil+H | J o

00:00; ENEREEN Banic Transfer
Conference ¥ Unszupervized Transfer...
Erhanced Transfer. .
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Result:

The current call will automatically be put on hold and a new
CIP will appear with dia tone.

¥ Smith, John 51537 M= B
File Edit Cal “iew pAgent Tool: Settings Help
XE’%|%‘{>§ gq)” Number:l [T S
£ Xsdw e alc
|| 20021 || atanes. Bob 51500 | £ Feconnect |
H| 000025 || b=mith, John 51537 | PRelease |
|
Fieady i

Enter the number of the party you want to transfer the call to. The
numbers are entered using the keyboard or Dial Pad.

When the second call is answered, you can privately talk to the party;
then select Basic Transfer again to complete the transfer.

Tip: You may complete the transfer at anytime after the number is
entered, during the ringing state, or after the second party answers.

Result:

Both CIPs disappear from your main callbar indicating that the
transfer was successful.

You may change the call transfer into a conference by selecting Basic
Conference instead of Basic Transfer in Step 3.

Lucent Technologies 585-215-110
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5 If there is no answer, the line is busy, or you decide the transfer is not
needed, do the following to cancel the transfer:

*  Click the Release button for the party that was going to receive
the transfer. This will release that call.

* Return to the held call by selecting the call state Reconnect
button for that held call.

END OF STEPS

Unsupervised Transfer  To transfer a call using Unsupervised Transfer, follow these steps:

1 While you are active on a call, select Call from the menu bar. Then
select Transfer and Unsupervised Transfer.

Result:

The Unsupervised Transfer box appears.

Unzupervized Transfer...

2 Inthe Unsupervised Transfer box, enter the number you want to
transfer your existing call to, as in the example below. The number
must be typed in, or it can be copied and pasted in.

Unzupervized Transfer...

Murnber: |51537 | OF. I

3 Click OK to transfer the cdal. You do not have to click the Transfer
button a second time to complete the transfer.

Result:

The CIP will disappear from your main callbar, indicating that
the transfer was successful.

END OF STEPS

585-215-110 Lucent Technologies 5-9
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Enhanced Transfer  To transfer a call using Enhanced Transfer, follow these steps:

1 While you are active on a cal, select Call from the menu bar. Then
select Transfer and Enhanced Transfer.

Result:

The Enhanced Transfer box appears.

Enhanced Transfer...

Humber: ak I

2  Inthe Enhanced Transfer box, enter the number you want to transfer
your existing caller to, as in the example below:

Enhanced Transfer...

Number: |51 537 ak, |

Important! The number must be typed in, or it can be copied and
pasted in.

3 Click OK. The caler will automatically be put on hold and a new CIP
will appear with dial tone.

5-10 Lucent Technologies 585-215-110
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Result:
The Transfer the Party? box appears.

Centre¥u IP Agent ] |

@ Tranzfer the party?

4  Remain on the line. If the number dialed is answered, announce the
cal. Then click the Yes button in the Transfer the Party? box.

Result:

Both CIPs disappear from your main callbar indicating that the
transfer was successful.

5 If the number dialed is not answered or is busy, click the No button in
the “ Transfer the Party?’ box. Click the Reconnect button to return to

the held call.

6 When finished, hang up or click the Drop button.

END OF STEPS

585-215-110 Lucent Technologies 5-11
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Basic Conference

Getting Started

Using Conferencing

Using Conferencing describes the following two methods of handling
conference calls:

* Basic Conference lets you add another party to a call. You select
Conference, dia the number, talk to the party to be added to the
conference, and select Conference again.

»  Enhanced Conference differs from a Basic Conference in that
you select Conference, type the number of the party to be added
into a text box, and click OK. After talking to the party, you can
either click Yes to add or No to not add the party to the call.

Tip: The Conference button can be configured for basic or enhanced
conference in the Options dialog box. However, you can override this
configuration. Just select Call on the menu bar and then select the
method of conferencing you prefer.

For more information on call conferencing, see[Call Menu [6-4 J For
more information on the Options dialog box, seelAdministerinq
[Options [7-5].|

To conference a call using Basic Conference, follow these steps:

While you are active on the call to be conferenced, select Call from
the menu bar. Then select Conference and Basic Conference.

L"-.Ali Machelney[Business])
File Editmyiew foent Tools Setting: Help

s E3

?(_ 3 Release umber:l—@ - 8 -
le @2 o

& Hald Chel+H H @|

n 00:30: Transfer F Lisiness)

Lonference Bazic Conference
Enhanced Conference...
A
Result:

The caler will automatically be put on hold and a new CIP will
appear with dial tone.

Lucent Technologies 585-215-110
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2  Enter the number of the party you want to add to the call conference.
The numbers are entered using the keyboard or the Dia Pad.

3 When the second call is answered, you can privately tak to the party;
then select Basic Conference again to initiate the conference call.

Tip: You may initiate the conference at any time after the number is
entered, during the ringing state, or after the second party answers.

Result:

One CIP appears on your main callbar displaying
"CONFERENCE 2" (indicating an active conference).

¥ CONFERENCE 2 IS
File Edit Call “iew Agent Toolz Settings Help

?<. Q?}|%| b}ﬂ &;J” Number:l—@; - G -
Lx[sd®e- 8|0

n| 00:00:30 || b= CONFERENCE 2 | " Heiease

Ready L

4 You may change the call conference into a transfer by selecting Basic
Transfer instead of Basic Conference in Step 3.

5 Repeat Step 1 through Step 3 until you have conferenced all parties.

Result:

The single CIP will display "CONFERENCE X,"” where X
equals the number of parties you added to the call.

585-215-110 Lucent Technologies 5-13
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Enhanced Conference

Getting Started

Example:

If you added three parties to the call, the display on the CIP will
say "CONFERENCE 3."

¥ CONFERENCE 3 =
File Edit Call “iew dgent Toolz: Settings Help

X E?}|% ‘QQ @9” Number:l—@ - 3 .
ey N

|| o238 | b= conFERENCE 3 | Rdeae |

Feady v

If there is no answer, the line is busy, or you decide the conference is
not needed, do the following:

*  Click the Release button for the party that was going to be added
to the conference. This will release that call.

* Return to the held call by selecting the call state Reconnect
button for that held call.

END OF STEPS

To add another person to a call, or conference a call, follow these
steps:

While you are on an active call, select Call.
Result:
The Call menu appears.

From the Call menu, select Conference and then Enhanced
Conference.

Lucent Technologies 585-215-110
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Result:

The Enhanced Conference Number box appears.

Enhanced Conference. .

3 In the Enhanced Conference Number box, enter the number of the
party you want to add to the call.

Important! The number must be typed in, or it can be copied and
pasted in.

4  Click OK. The caller will automatically be put on hold and a new CIP
will appear with dial tone.

Result:
The “Add Party to call?’ box appears.

Centre¥u IP Agent |
@ &,dd the party ko the call?
Mo

5 Remain on the line. If the number dialed is answered, you can
privately talk to the party. Then click the Yes button in the “Add Party
to call?’ box to add the party to the call.

585-215-110 Lucent Technologies 5-15
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Getting Started

Result:

One CIP appears on your main callbar displaying
"CONFERENCE 2" (indicating an active conference).

W CONFERENCE 2 M E3

File Edit Call “iew dgent Toolz: Settings Help

X E?}|% ‘QQ @9” Number:l—@ - 3 .

i <[sd® e - &0

n| 00:00:30 | b= CONFERENGCE 2 | [ Heiease ]

Ready

Result:

If the number dialed is not answered or is busy, click the No button in
the “Add Party to call?” box. Click the Reconnect button to return to
the original party.

Repeat Step 1 through Step 6 until you have conferenced all parties.

The single CIP will display “CONFERENCE X,” where X

equals the number of parties you added to the call.

Example:

If you added three parties to the call, the display on the CIP will

say “CONFERENCE 3

¥ CONFERENCE 3 =

File Edit Call “iew dgent Toolz: Settings Help

X E?}|% ‘QQ @9” Number:l—@ - 3 .

i <[sd® e - &0

“| 00:03:38 | b= CONFERENCE 3 | [ Heiease ]

Ready

v
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8 Any person on the conference call can hang up at any time. The CIP
will display "CONFERENCE X,"” where X equals the number of
parties left on the call.

9 To disconnect the last person added to the conference call, click the
Drop button.

10 When the conference cal is over, click the Release button.
Result:

The CIP will disappear from the main callbar.

END OF STEPS
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Getting Started

Handling Outgoing Calls

Introduction

Using Senderized Dialing

There are two types of dialing, Senderized (S-channel) or Cut-through.

Senderized dialing means that when you enter a dia string in the
Number text box, you must select the Dial Number button or Enter
key to actually dial the number. This type of dialing lets you edit the
dial string before sending it, which is handy for numbers that are
long.

You can also use a Speed-Dial list or Recent Calls List to quickly
select a number, or copy a number from a Persona Information
Manager or other calling list and paste it into the Number box.

Cut through dialing works just like a standard phone. The numbers are
sent as the keys are pressed. If you make a typing error, you must
hang up and try again. You can use the Dia Pad or type numbers
from the keyboard to enter the number.

Handling Outgoing Calls explains these two types of dialing.

Follow the steps below to make a call using senderized dialing:

Place your cursor in the Number text box.
Enter the dia string from the keyboard. The numbers are not sent yet
and can be edited if you make a typing error.
Important! In the English language version of 1P Agent, you may
intermix letters and numbers in the dial string. Letters will be
trandated to their number equivalent. Refer to the Dia Pad for the
letter to number equivalent.
To send the number:
*  Click the Dial Number button next to the Number box, or
*  Press the Enter key. The Enter key works only if the main
window is active.
Lucent Technologies 585-215-110
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Result:
A new CIP will be displayed.

& Jones. Bob 51500 [_ [l =]
File Edit Cal “iew Agent Toolz Settings Help

s Q%|%§Q ﬂq)” Numberl—@-vg
b Edw 8-

“| 00:00.21 || a=Jones, Bab 51500 | Fiekase |

Ready s

4 To make another call, repeat Step 1 through Step 3.
Result:

The call you were on (for example, Jones, Bob 51500) will
automatically be put on hold and the CIP button for that call
will change to Reconnect.

5 A new CIP will be created with the dial string displayed (for example,
Smith, John 51537) and its CIP button will be Release.

B Smith, John 51537 =

File Edit Cal “iew Agent Toolz Settings Help

><. g’*‘>|% bid ﬂ?” Number:l—@ - il .
£eeds e a|d

I oo00:21 | emtones, Bob 51500 | {Hecoment |
n| 00:00:26 | b=Smith, John 51537 | Release |

Ready s

END OF STEPS
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Using Cut-Through Dialing

Getting Started

To make a call using cut-through dialing, use the following
procedures:

To obtain a dial tone:
. Click the Dial Number button next to the Number box, or

*  Pressthe Enter key. The Enter key works only if the main
window is active.

Result:
A new CIP will be displayed and you will hear a dial tone.

Enter the dia string using the keyboard or use the Dial Pad.

DialPad H
&2EC DEF
1 2 3
SHL JEKL MNO
4 5 [i]
PORE TOYV N2
8 o
&= 0 i
Result:

When you type a number, it is automatically sent and displays
in the CIP.

If you type the wrong number, you must hang up and start over. No
editing is possible.

You can use the keyboard and Dial Pad aternately.

Example:

If you were dialing the number 51500, you could enter the 51
using the keyboard and then enter the 500 using the Dia Pad.

When the last number is entered, the called phone will start ringing.
END OF STEPS
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Speeding-Up Outgoing Calls
Introduction  There are several ways you can make the handling of outgoing calls
more efficient. You can use a recent calls list, a speed dial number, or
an abbreviated dia button.

Using a Recent Calls List  You can quickly dia or redial recent incoming or outgoing calls by
using a recent calls list. Phone numbers are not duplicated in the list,
so if the last ten calls are to the same number, the number will only
be displayed in the list once. Calls are only added to the list if they
contain a valid phone number.

Some points to know about the recent calls list are:

* You or your system administrator can control the number of
recent call numbers displayed by setting the number in the
Options dialog box. See[Administering Options [7-5]| for more
information.

e  Thelist may show the last 25 unique numbers recorded in the
Call History log. Numbers from other sources (abbreviated dial
buttons or numbers dialed on active calls (pin numbers) are not
included in the list.

o Letters dialed (for example, 1800FLOWERS) will appear in the
recent calls list as entered, and not as the number trandation.

Procedure To make a call using the Recent Calls list:

1 Click the down arrow next to the Call History button.
Result:

A list of previously dialed or previously received numbers
appears.

Call FROM J03-555-5505
Jones, Bob 51500

Smith, John

Jim ‘W oodz [Buzsiness)

2  Click the number you want to dial.
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Administering Speed
Dialing

Getting Started

Result:
The CIP will look like the following example:

04 |a=Smith,.J|:|hn 51537 | ! Helease

The phone number is sent and the called phone will start ringing.
END OF STEPS

IP Agent lets you determine speed dial numbers in the Phone
Directory Properties dialog box. A speed dial number can be any
number in the Phone Directory, up to a maximum of 25 numbers.
To use speed dialing, follow these steps:

In the IP Agent main window, click the Phone Directory button.

Result:

The Phone Directory dialog box appears. Here is an example of
a Phone Directory with button callouts.

Delete |

Mew Entry

| Froperties | |

Diial Hurmber

B& Phone Directory
File Edit %iew Fhaone

| Category: I 'I

) | Categomy I
+1 9185551365 | Apex Incor...
+1 [564]) BE5-2365 | Apex Incor...
+1 [420) BB5-EER4 | Apex Incor...
+1 [303) 555-8376 | Apex Incor...

+1 [303) 555-3245 | Apex Incor...
Ready 4

Name:|—| @ ?{ |

MName I Mumber

Ali W achelney

arnie Hazkins
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2

Getting Started

In the Phone Directory menu, do one of the following:
» If you are creating an entry, click the New Entry button.

* If you are editing an entry, highlight the entry. Select View and
then select Properties.

Result:

The Properties dialog box appears.

Properties

Mame: Category: _..| | ~| Speed
Hame || ateqgory: J Dl
Address: BusinessJ I -
Home J I =
Email: Pager J I =

Maotes: ™ Dial number on curent call.

k. I Cancel |

Enter or edit the appropriate information in the Properties dialog box
fields.

Important! For more information on the Phone Directory and Phone
Directory Properties dialog boxes, see|Using the Phone Directory|

Check the Speed Dial button next to the phone number that you want
to administer as a speed dial number.

To use a speed dia number, in the P Agent main window, click the
down arrow next to the Phone Directory button.

585-215-110
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Using an Abbreviated Dial

Button

Getting Started

Result:
The speed dia list appears.

Albert Fenney [Home|

Ali Machelney [Home]

Bobby Leeland [Businessz)
Came Hazkins [Business]
Jim Wwoods [Businessz)

The phone number is sent and the called phone will start ringing.
END OF STEPS

If the Abbreviated Dial feature has been administered on the
DEFINITY ECS for your physical station terminal, you can store
selected telephone numbers in the Phone Features dialog box for
quicker and easier dialing. Each number can be a complete or
partial telephone number, an extension number, or a trunk or
feature code. To make a call using an Abbreviated Dial button,
follow these steps:

In the Phone Features dialog box, click the Abbreviated Dial button
containing the number you want to dial.

Result:

The digits of the phone number will appear in the display area
of the CIP.

Tip: The button label for an abbreviated dial is a number (for
example, 51008); and the button label for an auto dia button is
autodia plus the number (for example, autodial 51008).

The phone number is sent and the called phone will start ringing.

END OF STEPS
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Using the Phone Directory
Introduction  You can store names, addresses, email addresses, notes, and phone

numbers in the Phone Directory. The directory will support multiple
numbers for each entry.

The directory entries can be displayed with the following views: large
icons, small icons, list, and detailed. In the detailed view, the entry’s
name, number, email, category, and notes are listed. The number
displayed in this view is the first number found for the entry if
multiple numbers are entered. The directory entries can be sorted by
name, number, or category.

Procedures  To use the Phone Directory, follow these procedures:

1 Inthe IP Agent main window, click the Phone Directory button.
Result:

The Phone Directory dialog box (detailed view) appears.

[M& Phone Directory M= E3
File Edit “iew Phone

Name:l | & x |I |Categnr_l,-:| 'I
M ame | Murmber 0¥ | Cateqgory |

B &l M achelney +1 9185851365 Apex Incor...

| Bobby Leeland +1 [BE4] BBE-2365 | Apex Incor...

= Carrie Hasking +1 [428] BBE-BERL | Apex Incor...

ert Fenney +1 [303) 555-8976 | Apex Incar...
& Jim Woods +1 [303) 555-3245 | Apex Incor...
Ready o

2 To cal a number from the Phone Directory, click the name in the
directory list.
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Using the Phone Directory

Adding to the Phone
Directory

Result:

Getting Started

If the name in the directory entry has more than one number, a
popup menu with a list of numbers appears.

[N Phone Directory
Fil=  Edit “iew FPhone

IS E3

Name:|—| o3 ?( |

| Categony: IAper: Incorpaorat "I

M ame

| Murmber

¥ | Category

& Al Machelney
Bobby Leeland

+1 918 BE5 1365
+1 [BE4] B55-2365

Apey lncor...
Apey lncar...

Lucent Technologies

7| Carrie Hazking

+1 [425) 5556654
+1 [303) 555-0976

555-3245

Apey lncar...
Apey lhcar...

Apex Incoar...

bert Fenney
Albert Fenney [Business Fax)
Re: Albert Fenney (Home) 7

Click the Dial Number button in the Phone Directory to dial the
number.

If you want to create an entry in the Phone Directory or edit an entry,
you need to use the Properties dialog box. See Adding to the Phone
Directory [5-26] or [Editing the Phone Directory [5-28] ]

To remove an entry from the Phone Directory, highlight the entry and
click the Delete button.

Result:

The entry is deleted from the Phone Directory.

END OF STEPS

The Phone Directory Properties dialog box enables you to add a
new entry to the phone directory. You can add or edit directory
entries using the Properties dialog box. To display the Properties
dialog box, follow the steps below.

585-215-110
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Result:

The Properties dialog box appears.

Properties

Mame: Category .| | | Speed
Mame || ategory, J 2=
Address: BusinessJ I I~
Home J I I~
Email: PagerJ I il

Mates: ™ Dial number on curent call

ok I Cancel

2  Enter the customer’s name in the Name field. The Name value is used
by the program when displaying this entry in the Call Information
Panel or Call History log.

3  Complete the Properties dialog box fields, as appropriate. Use the tab
key to move from field to field.

4 In the Address field, enter the customer’s address. Press Ctrl +Enter to
move the cursor from one line to another.

7  In the Category, click the down arrow to see a list of categories and
select the category the customer belongs to.

Tip: See|Editing Categories [5-29]| for information on changing or
adding a category.

8 Enter the customer’s phone number or numbers in the phone number
type fields—Business, Home, or Pager.
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10

Editing the Phone
Directory

3

Getting Started

Tip: See|Changing Phone Number Type L abels [5-29]] for information
on how to change the labels on these fields.

If you want to add a phone number to your speed dial list, click the
speed dial button.

When finished using the Properties dialog box, click OK to exit.
Result:

The Phone Directory dialog box displays the additions or
changes you made.
END OF STEPS

The Phone Directory Properties dialog box enables you to edit

directory entries.
To edit a directory entry, click the entry in the Phone Directory dialog
box.
To display the Properties dialog box, click the Properties button.
Result:
The Properties dialog box appears.
(WENEM[E obby Leeland Category J IApexIncorporate l E[D)?;d
Address: BusinessJ |+1 [664) BA5-2365 v
Home J |+1 (918) 555-3349 |
Ernail PagerJ I r
Naotes: ™ Dial number on curent cal
QK. I Cancel
Make the appropriate edits to the fields in the Properties dialog box.
Lucent Technologies 585-215-110
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4 When finished making edits, click the OK button.
Result:

The changes will appear in the Phone Directory dialog box.
END OF STEPS

Editing Categories

You can add, rename, or remove a category in the Phone Directory
Properties dialog box by selecting the Edit Categories option.

To edit a category, follow these steps:

1. Click the “...” button next to the Category label. The Edit
Categories dialog box appears.

E dit Categories |

Alert Secunty Spzt .
Belco Lighting 7

CLOA,

Centurion Building__

DTT

Hodge Inc.

HEAEE FIc ll Cloze

Click Add to create a new category.

3. Highlight a category and click Remove to remove it. You can
administer up to 10 categories.

4.  When finished editing categories, click Close. You are returned to
the Properties dialog box.

Changing Phone Number Type Labels

The Phone Directory supports multiple phone numbers for each entry.
The following phone number types are supported: Business, Business
Fax, Home, Home Fax, Mobile, Car, Assistant, Company, and Pager.
The phone number labels in the Phone Directory Properties dialog box
are initialized to Business, Home, and Pager. However, you can
change these labels to any of the above phone number types.
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To change the phone number type labels, follow these steps:

1. In the Phone Directory Properties dialog box, click the “...”
button next to the phone number type label.

2. A popup menu appears containing the remaining phone number
type labels that are not displayed. A check mark next to a label
means that the label is already administered.

Buzineszz Fax
Horme Fax

b bl
Azziztant

Car
Company

3. From the popup menu, click the label you want on the button.
The label is changed on the button.
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Using the Call History Log

Introduction

Procedures

2

Getting Started

The Call History log stores information on incoming and outgoing
calls by automatically generating a call record, or one-line summary
of each call. You can add or modify notes in the record, delete the

cal record, or dial the sdlected number from the record.

Important! This topic contains easy-to-follow procedures on how to
use the Call History feature. For detailed information on the Call

History log, see|Viewing Call History [6-21].|

To use the Call History log, follow these procedures:

On the IP Agent menu bar, click the Call History button.

Result:

The Call History log appears. Here is an example of a Call

History log with button callouts:

Add to Directony

Diial Humber |

Delete

& Call History - Today - Thursday. 11/18/99
FEile Edit Phore

Dates:IToda_l,l v” Zx | = >
| Hame | Mumber | Date | Tirne | -
4-| Ali Machelhey [Business) +1 [318) 555-9237 | Thu, Mow 18, 19...

Q Avslliary Work tMode Thu, Mow 18,13, 05:20 PM
Q Agent Login Thu, Now 18,19, | 05:20 P
Q Agent Logaut Thu, Mow 18,19, 05:18 PM
= Albert Fenney [Business) +1 [303) BBE-B37E | Thu, Mow 18,13, | 05:01 PM
4= Carie Haskins [Home] +1 [303) BB5-6654 | Thu, Mow 18,19, 04:52 P
Q After Call'wark Mode Thu, Mow 18,79 | 04:48 PM
4= lim woods [Business) +1 [BE3) BB5-3245 | Thu, Mow 18,19, | 04:44 Phd
= loe Bifsk [Pager) +1 (563 555-5555 | Thu, Now 18,19... | 04:38 PM

= Daisy Mae McGraw [Home] | +1 [563) 555-8902 | Thu, Now 18.19... | 04:34 PM
4= Brian Daubert [Cell Phone) +1 [BE3) BB6-6873 | Thu, Mow 18,19, 04:29 Pk
= [ auphne Belmont [Home) +1 [303) 555-4821 | Thu, Mow 18,19, 04:25PM
4m Bobby Leeland [Business) +1 [BE3) BBE-2365 | Thu, Mow 18,13, 04:21 PM

4= Albert Ferneo (Rusiness) +1 AN RAR-R97F | Thie Mo 1f€ 19 M4-18 PR _ILI
A 3
Ready o

To call a number from the Call History log, click the record

containing the phone number you want to dial.

585-215-110
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Getting Started

To dial the number, click the Dial Number button. You may also call
a number by simply double-clicking the icon preceding the call
record.

To edit arecord in the Call History log, highlight the record and
select Edit from the menu bar.

Tip: You can edit the Name, Number, and Notes fields.

To add a record from the Call History log to the Phone Directory,
highlight the record and then click the Add to Directory button.

Result:
The entry is added to the Phone Directory.

To delete a record from the Call History log, highlight the record and
click the Delete button.

Result:
The entry is deleted from the Call History log.

END OF STEPS
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6 Using IP Agent

Overview

Purpose Using IP Agent describes the menus and panels in the IP Agent main
window. It also explains how to use IP Agent features, such as reason
codes and the call history log.

Using IP Agent covers the following topics:

e |Learning the Main Window [6-2]|

» |Displaying Toolbars and Dial Pad [6-11]|
« [Viewing Panels and Status Bar [6-13]|

« |Using Phone Feature Options [6-15]|

« [Using Reason Codes [6-19]

[Viewing Call History [6-21]]

[Searching the Public Directory [6-23]]

For information on starting 1P Agent, logging into the DEFINITY®
ECS, and logging into IP Agent, see Getting Started.
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Learning the Main Window

Introduction

File Menu

Using IP Agent

The IP Agent main window provides full-function, multi-line
telephony support on your PC. A representation of the Main Window
with callouts of all of its components is available in IP Agent Main

Window [1-2].

Learning the Main Window defines all of the options available in the
IP Agent menus. Not all of the items will be available to you al of
the time. If an item is not available in the current window, it is grayed

out.

Select File to open the File menu, as shown below:

¥ Smith. John

Edit Call View pgent Toole Settings Help

WERIHIT Cogim.. Ell

51537 M=l E3

” Number:l—@? e

Import Settings...
Export Settings...

p - &[0

Exit

21237 | e

i

The following table lists the File menu commands and a description

of each command.

Menu Item

DEFINITY
Login (Ctrl+L)

Import Settings

Export Settings

Description

Displays the DEFINITY Login window. If you are
already logged in, this item is grayed out.

Displays an Open dialog box for finding retrieving
previously saved files containing phone settings,
program options, and configurations.

Displays a Save As dialog box for naming a file
that will contain phone settings, program options,
and configurations for later use.
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Menu Item Description

The options imported and exported include all the options displayed
on the Options dialog box except the “Voice Message Directory
Entry” option. The configuration information includes all
administered call events along with the DDE or Web Page triggers.
It also includes Public Directory administration and the DEFINITY
server name or |P address. Select Options from the Tools menu to
review the Options choices.

Exit Quit the application.

Edit Menu  Select Edit to open the Edit menu, as shown below:

¥ Smith. John 51537 [_ 5]
Eilegall Wiew Agent Toolz Seftings Help
Cut  Ciex 3 H Mumber: (EEEES & v B
Copy  ChlC
Paste Chil+yf @ &2 "| ﬂ‘ H C‘
n| 00:02:52 || Smith, John 51637 | Release |

i

The following table lists the Edit menu commands and a description
of each command.

Menu Item Description

Cut (Ctrl+X)  Cuts any text selection, such as names or numbers,
in the number text box.

Copy Copies any text selection, such as names or
(Ctrl+C) numbers, in the number text box.
Paste Pastes any text selection, such as names or numbers,
(Ctrl+V) in the number text box.
585-215-110 Lucent Technologies 6-3
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Call Menu

Using IP Agent

Select Call to open the Call menu, as shown below:

¥ Centrevu IP Agent - 47770 - [Agent 46720] M= E
Fil=  Edit m YWiew pgent Toolz: Settings Help
?(_ i§3. helease umber: I——

Dop

Hold

Transfer

o |2I€

Bazic Transfer
LConference ¥ Unsupervized Transfer
Enhanced Transfer...

The following table lists the Call menu commands and a description
of each command.

Menu
Command

Release
(Del)

Drop

Hold
(Ctrl+H)

Transfer
(Ctrl+T)

Submenu
Command
and Buttons

x

i

Basic
Transfer

Description

Releases the call.

Disconnects from a call without
requiring you to hang up the handset,
turn off the speakerphone, or press the
switchhook. Used mainly to disconnect
the last party added to a conference
call.

Puts a call on hold until you can return
to it. While the call is on hold, you can
place another call, activate another
feature, answer a waiting call, or leave
your voice terminal. Use when you
have a call that you don’t wish to drop,
but which you have to interrupt briefly
to do something else.

Sends a call from your voice terminal
to another extension or outside number.
Use when your caller needs to speak
further with someone else.

Select Transfer, dial the number,
announce the call, and select Transfer

again.
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View Menu

Using IP Agent

Menu
Command

Conference

Submenu
Command
and Buttons

Unsuper-
vised
Transfer

Enhanced
Transfer

&

Basic
Conference

Enhanced
Conference

Description

Select Transfer, type the number to be
called into a text box, and click OK to
transfer the call. You do not talk to the
party receiving the transferred call.

Select Transfer, type the number to be
called into a text box, and click OK.
After announcing the call, you can
either click Yes to transfer or No to not
transfer the call.

Allows you to add parties to a call.
Use to set up time-saving conferences,
or to spontaneously include a party
important to a discussion.

Select Conference, dial the number,
talk to the party, and select Conference
again.

Select Conference, type the number to
be called into a text box, and click
OK. After talking to the party, you can
either click Yes to add the party or No
to not add the party to the call.

Select View to open the View menu, as shown below:

¥ 5mith, John
Eile Edit Cal

| = | §v PhoveDisplay o [g8765 S NE: I
————————— v [ial Pad
& |« &[0
Toolbars 3
n 00:04-35 f« Shatus Bar 51537 | " Heiease |

51537

BCER Agent Toolz  Settings  Help

s 3

Z

Thelfollowing tabld lists the View menu commands and a description

of each command. For more information on toolbars, see[Displaying
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[Toolbars and Dial Pad [6-11])

Using IP Agent

Menu Submenu
Command Command
and Buttons

Phone
Display

Dial Pad

Toolbars Phone
Button

——— Dial
@ Number

Agent

Headset

Status Bar

Description

Displays the Phone Display panel,
which displays information such as
VuStats data or call prompting digits.

Displays the Dial Pad, which may be
used to enter numbers for cut-through
dialing. See[*Using Cut-Through

Displays the Phone Button toolbar,
which contains those buttons most often
used.

Displays the Dial Number toolbar,
which provides a senderized dial box
and access to various lists. This toolbar
contains the Dial Number button.

Displays the Agent toolbar, which
provides buttons for EAS agent login
and logout and agent modes.

Displays the Headset button, which you
can use to toggle the headset or handset
on or off hook. This is used for
Auto-Answer stations or agents, as
administered by your switch.

Shows or hides the status bar, which
displays the current activity or state of
IP Agent and Tool Tips.
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Agent Menu
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Using IP Agent

Select Agent to open the Agent menu, as shown below:

¥ Smith, John

File Edit Call Yiew g8 Tool: Seting: Help

51537

x Qq,| % W ke Kl

& |8 &

Agent Logout

v Auton Mode

n a=Smitt Manualln Mode

After Call Wwhark

Avplliary Work bode  Crrled,

ASEsleh

= E
etz . @ - £ .
Ctrl+Drel
Ctrl+l
Cirl+h —‘ Heleasel
Chrhiad
[EfrliS &

The following table lists the Agent menu commands and a description
of each command.

Menu
Command

Agent
Login
(Ctrl+Ins)

Agent
Logout
(Ctrl-Del)

Auto-In
Mode
(Ctrl+1)

Manual-In
Mode
(Ctrl+M)

After Call
Work
(ACW)
(Ctrl+W)

Buttons

&

&%

Description

Displays the Agent Login dialog box,
which enables you to enter your EAS
Agent login ID number and Password to
log into agent mode and the skills
associated with that mode on the switch.

Enables you to log out of agent mode and
the skills associated with that mode on
the switch.

An Automatic Call Distribution (ACD)
work mode. In the Auto-In mode, when
you disconnect from a call you are
automatically available to receive another
ACD call.

An ACD work mode that makes you
available to receive an ACD call and
automatically places you into the ACW
state upon release from the call.

An ACD work mode that allows time to
wrap up call-related work before the next
ACD call is delivered.
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Using IP Agent

Menu
Command

Auxiliary
Work
Mode
(AUX)
(Ctrl+A)

Assist
(Ctrl+S)

Buttons

=

Description

An ACD work mode indicating that you
are unavailable to receive an ACD call .
You may have to enter a reason code to
go into the AUX work mode, depending
on the administration of your switch.

Allows you to request assistance from the
skill supervisor by pressing the Assist
button. If you have a call up and click the
Assist button, the request will go to the
split supervisor assigned.

Tools Menu  Select Tools to open the Tools menu, as shown below:

;“ Centre¥u IP Agent - Hot Logged In
Filz  Edit Miew Agent | Tools Settings  Help

¥ B s o8

‘Wiew program options

& % | &€ &Y

Ehrre Features
EersanallEeatures

Phone Directony Alt+Dr

Screen Pops

Search Public Directony...

The following table lists the Tools menu commands and a description
of each command.

Command

Phone
Features

Personal
Features

Menu Buttons

Description

Opens the Phone Features dialog box, which
lists all feature buttons administered on the
switch for this phone.

Opens the Personal Features dialog box,
which consists of a list made up selected
feature buttons from the Phone Features
dialog box.
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Menu Buttons Description

Command

Phone ; Opens the Phone Directory, which stores

Directory E3 names, addresses, phone numbers, and other
L | information.

Call Opens the Call History log, which contains

History call history information including calling

&

party name, calling party number, date, time,
duration, and call notes.

Screen Opens the Screen Pop administration dialog
Pops box.

Search Provides access to corporate or public
Public directory services, thereby letting you query
Directory and manage a database, such as a directory,

over a TCP/IP connection.

Options Opens the Options dialog, which allows you
to administer various options, such as
whether to display IP Agent on top of other
windows, what type of font to use for call
display information, whether to display
tooltips for toolbars, and so forth.

Settings Menu  Select Settings to open the Settings menu, as shown below:

B S mith, John 51537 = I=)

File Edit Call Yiew Agent Tools ESENGHEE Help
> QQ}| %. W 3 H Mu Qie-lling Properties. . I'@; . .
e @s e E0

B/ coos:41 || a=smith. Jonn 51537 Il
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Help Menu

Using IP Agent

The following table lists the Settings menu command and a
description of each command.

Menu Description

Command

Dialing Opens the Windows® Dialing Properties dialog
Properties box. When you dial a number from IP Agent, the

number will be formatted based on the information
configured on the computer in the Dialing

Properties dialog.

Select Help to open the Help menu, as shown below:

¥ Smith, John 51537

File Edt Call Wiew Agent Took Settings [EEI

Pl E"’>| Ql i @9” Number: [g7  Contents

SIS E3

e L|ledm -G

J D About Centret'u 1P Agent
I

3 |

-

n| 00:07:17 || a=3mith, John 51537

| i Releaze

%

The following table lists the Help menu commands and a description
of each command.

Menu Command Description

Contents Selecting Contents opens the IP Agent
on-line help table of contents.

About CentreVu IP

Gives information on |IP Agent, including
Agent the copyright date and the version number.

L]
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Displaying Toolbars and Dial Pad

Introduction  The following toolbars are associated with the IP Agent main
window—Phone Button, Dial Number, Agent, and Headset. These
toolbars contain buttons that you can use for quick access to specific
commands and tools. Based on your user permissions, some or all of
the buttons will appear on the toolbars when you are logged into
agent mode. You can move the toolbars to the top or bottom of the
window or display each in its own separate window. To do this, click
on the left-most portion of the desired tool bar and drag to a new
position. Repeat the step to return the toolbar to the main panel.

The Dia Pad is also discussed here.

To see examples of the toolbars with callouts of the names of each
button, see|IlP Agent Main Window, Toolbars [1-4].|

Phone Button Toolbar

The Phone Button toolbar provides quick access to the basic phone
buttons. Release, Drop, Hold, Transfer, and Conference.

An example of the Phone Button toolbar is shown below:

K Do | Ga vl D

Dial Number Toolbar

The Dia Number toolbar provides a Number text box and access to
the Phone Directory, Call History log, speed dia list, and recent calls
list. When you enter a partial string in the Number text box (for
example, 303 or Jo) followed by enter, a popup menu displays with a
list of the directory entries that start with that string (for example,
303-555-5555, 303-555-5550, Johnson, John, or Joanne). If the first
character of the number is a letter, the title of the field will be
changed from Number to Directory.

The Dial Number toolbar looks similar to this:

Numl:uer:l &Y ~ CH -
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Agent Toolbar

The Agent toolbar provides buttons for EAS agent login and logout
and agent modes (Auto-In, Manual-In, After Call Work, AUX work
mode, and supervisor Assist).

Here is an example of the Agent toolbar:

& € |8 & B|al-| &

Headset Toolbar

The Headset toolbar displays a button you can use to toggle the
headset or handset on or off hook.

The Headset toolbar looks like this:

=]

Dial Pad

The Dial Pad displays the numbers that are on a telephone dial pad. It
contains 12 push-button that you use to dial a number and access
features.

The Dia Pad looks like this:

DialPad E
AEC DEF
1 2 3
GHL JEL MNO
4 & (i
PORS TOV EEVE
T 8 9
= 1] i
]
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Using IP Agent

Viewing Panels and Status Bar

Introduction  The IP Agent main window contains a panel at the bottom of the
window that serves as both a Call Information Panel (CIP) and an
Agent Information panel. You can also display another panel, the
Phone Display Panel, by selecting View and then selecting Phone
Display.
To display the status bar, select View and then select Status Bar.
Call Information Panel

The CIP appears only during an incoming and outgoing call. It
provides information about the call, such as call status, call display,
call duration, and control buttons (for example, Answer/Release and
Reconnect). If the number associated with the call display isin the
Phone Directory, the call display will contain the display name in the
directory and not the display information from the switch.

The call status—incoming, outgoing, or on-hold—is displayed in the
first section. Click the right mouse button on the CIP to display a
popup menu containing feature buttons, such as hold, transfer, and
conference.

An example of the Call Information Panel is shown below:

00 004 \ a=Smith, John 51537 \ T Belease |

Agent Information Panel

The Agent Information panel appears when there are no calls and
there is status information. If you are logged in, the status information
also includes the agent mode state (for example, Auto-In and Manual
In).

An example of the Agent Information panel is shown below:

| Manual-In Mode | A T | |

585-215-110 Lucent Technologies 6-13
Issue 1, March 2000



Viewing Panels and Status Bar

Using IP Agent

Phone Display Panel

The Phone Display panel is a 40-character display that is located
under the CIP. This display area is updated automatically with
information from the DEFINITY ECS so that you can see call and
non-call related information, such as call prompting digits, VuStats
data, and the local time/date display from the switch.

Here is an example of the Phone Display panel:

| a=lnfo: 1111222233334444

Status Bar

The status bar is located at the bottom of the IP Agent main window
and displays IP Agent application status. It also displays a brief
description of each of the toolbar buttons when the mouse pointer is
over the button. If you have activated "Send All Calls,” the default
string will be changed from "Ready” to "Ready - Send All Calls
Activated."

Ready A
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Using Phone Feature Options

Introduction

Phone Features
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The Phone Features dialog box displays in a tree view all feature
buttons administered on the switch for this physical station terminal,
which may include reason codes. The features are divided into the
following groups: Abbreviated Dial, Call Center Features,
Miscellaneous Features, and Stroke Count.

You can select any feature button to add to your Persona Phone
Features dialog box to create a personalized summary of your most
used buttons.

To access the Phone Features dialog box to set phone features,
follow these steps:

In the IP Agent menu bar, select Tools and then select Phone Features.
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Using Phone Feature Options

Result:

The Phone Features dialog box appears.

¥ Phone Features M= E3

=3

0000000000%00000000

Al Reazon Codes

M=
O
T

Add to Perzonal List

Lunch
Chinrer
Coffee break

Amiliany wiork, Mode 3
Amiliary wWork, Mode 4
Appailiary work, Mode &
Amiliany wiork, Mode &
Amiliary wWork, Mode 7
trok.e Counts

Stroke Count [
Stroke Count 1
Stroke Count 2
Stroke Count 3
Stroke Count 4
Stroke Count &
Stroke Count B
Stroke Count 7
Stroke Count 8

Autormaitic Dial 1
Sy tnmaibic Dial 2

e
—

Using IP Agent

When a phone feature button is activated in IP Agent, the icon next to
the button is green. To activate a button, double-click on the icon.

To copy your most frequently used phone feature buttons to your
Personal Phone Features dialog box, highlight the feature and select
Add to Personal List.
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Personal Features

2
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Using IP Agent

To rename or change the button labels in the Phone Features dialog
box, right-click on the button and select Rename from the pop-up
menu. Then type the new name in the button box.

For example, You could replace an “Abbreviated Dial” digit string
with a label such as “Marriott.”

Important! If the button you are renaming is also in your Personal
Features dialog box, the name will be changed there as well.

Depending on your privileges, you may delete a button from the
Phone Features dialog box by selecting it and clicking the Delete key
or clicking the right-mouse button and selecting Delete.

To restore the button label back to its origina switch administered
label, highlight the button, right-click, and select Restore.

END OF STEPS

In the IP Agent menu bar, select Tools and then select Personal
Features.

Result:

The Personal Features dialog box appears.

O “uStats: 1

O Automatic Call Back

O Abbreviated Dialing Program bMode
E Mommal Mode

To activate or deactive a feature, double-click on the icon or string.
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3 To delete a button from the Phone Features dialog box, select it and

press the Delete key, or click the right-mouse button and select
Delete.

END OF STEPS
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Using Reason Codes

Introduction

AUX Reason Codes

Logout Reason Codes
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There are two different types of reason codes—AUX (Auxiliary)
reason codes and Logout reason codes. Reason codes enable a call
center to track your time more precisaly, which is then reported in
real-time and historical reports.

You use an AUX reason code to specify why you are in the AUX
state (for example, lunch, break, or meeting). Here are some points to
keep in mind when using AUX reason codes.

 AUX reason codes are single digits, O through 9.

. You can rename or view AUX reason code names in the Phone
Features dialog box.

e AUX Reason Code 0 is used for cases when the switch
automatically puts you into AUX.

 The DEFINITY EAS feature is required to use the AUX reason
codes feature.

How AUX Reason Codes are Administered

The first station administered AUX reason code will be assigned to
the Auxiliary Work Mode (AUX) button on the Agent toolbar.

If multiple AUX reason codes are administered on the station, they
will appear in the Phone Features dialog box under the “AUX Reason
Codes’ category and on the menu associated with the AUX button.

If your Agent toolbar contains an AUX button that was administered
without a reason code, you will be prompted to enter a reason code.
This prompt will appear on the Phone display panel. Type the number
associated with your reason for going into AUX work mode.

You use a logout reason code to explain why you are logging out (for
example, end of a shift or training). Here are some points to keep in
mind when using logout reason codes:

» Logout reason codes are single digits, 0 through 9.

* Logout Reason Code 0 is used when the system logs you out, or
if you do not specify a code.

« The DEFINITY EAS feature is required to use the logout reason
codes feature.
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Depending on your DEFINITY EAS administration, you may be
required to enter a logout reason code before you can log out of agent
mode. In the Number text box, type the number associated with your
reason for logging out.

U
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Viewing Call History

Introduction

Using IP Agent

The Call History log displays information about incoming and
outgoing calls. The information stored includes the name of the
person, the number dialed or the number received, date, time, and
duration of the call. It also includes agent login and agent state
modes, such as auto-in, agent login, agent logout, and after call work.
The log contains a menu bar, toolbar, status bar, and a call history

record.

For more information about the Call History log, including adding
Call History numbers to the Phone Directory, see[Using the Call|

[History Log [5-31] .|

&= Call History - Today - Thursdap. 11/18/99 ME E
File Edit Phone

Dates: ITDda_l,l j| &) | 1= X

| M arme | Murmber | D ate | Time | -
‘-I Ali Machelney [Bus +1 [318) BB5-9237 Mow 18, 19... | 05

E Avpelliary Wwork Mode
Q Agent Login

E Agent Logaout

=) Albert Fenney [Business)
4= Carie Hasking [Home)

& fter CallWark Mode

4= Jim\Woods [Business]
=} e Bifsk [Pager)

= [aizy Mae McGraw [Home)
4= Erian Daubert [Cell Phone)
= [auphne Belmont [Home)
4= EBobby Leeland [Business)
{hl Alhert Fenneu (Rusziness]

+1 [303) 555-8976
+1 [303] 555-6654

+1 [B63] 555-3245
+1 [B63) 555-5555
+1 [563] 555-8302
+1 [B63) 555-6873
+1 [303] 555-4521
+1 [B63) 555-2365
+1 [3N31 ARR-AS7R

Thu
Thu,
Thu,
Thu,
Thu,

Thu
Thu
Thu,
Thu,
Thu,
Thu,
Thu
Thu

Moy 18,19
Mow 18, 19..
Mow 18,19
Mow 18, 19..
Mow 18,19
 Mow 18,149...
Moy 18,19
Mow 18, 19..
Mow 18,19
Mow 18, 19..
Mow 18,19
 Mow 18,149...

I e 1|q 19

Ready

05:20 P
05:20 PM
05:15 P
05:01 PM
04:52 P4
04:48 PM
04:44 P4
04:38 PM
04:34 P4
04:29 PM
04:25 PM
04:21 PM

M4-18 Pk _ILI
L3

i

The symbols on the Call History dialog box are as follows:

Incoming call:

585-215-110
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Using IP Agent

Outgoing call:

4

Missed call:

4

Agent status:

5

The Cal History log contains the following fields:

Name field: Contains the name of the calling party, followed by
the number type (for example, business, home, or fax). For agent
mode records, the Name field contains the agent mode state, such
as Agent Login or Manual-In.

Number field: Contains the phone number dialed for outgoing
cals. For incoming calls, the number displayed depends on the
features provided by the switch. If the switch provides caler
identification information, that number will be displayed.

Date and Time fields: Contain the date and time the call
originated.

Duration field: Displays the length of the call.

Notes field: Contains optional information entered by the user.
This field supports 255 characters.
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Searching the Public Directory

Introduction

Procedures

2

585-215-110
Issue 1, March 2000

The Search Public Directory feature provides access to corporate or
public directory services. It lets you query and manage a database,
such as a directory, over a TCP/IP connection.

Important! This feature is also called Search LDAP (Lightweight
Directory Access Protocol).

To search the Public Directory, follow these procedures.
Access the Search feature by doing one of the following:

* IntheIPAgent menu bar, select Tools and then select Search
Public Directory, or

* In the Phone Directory menu, select File and then select Search
Public Directory.

For more information on the Phone Directory, see{Using the Phong|
[Directory [5-25].|

Result:

The Search Public Directory dialog box appears.

ER' Search Public Directory

File Edt “iew Phone SearchFor

Name:l ES.S | Loak in:lcompan_l,l LDAP 'l | &p |
Mame o | Humber | Email | Organization | City

1] | ©
Search the directom for a phone number, o

Select Search For on the menu bar to display the type of data to look
for: Name, Phone Number, or Email Address.
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Result:

The type of data you select appears as the label for the first text
box; for example, if you select Phone Number, the label changes
from Name to Number.

Number:l @ | Laak in:lcompany LDAP 'I | @ |

3 Inthe first text box enter the Name, Number, or Email (depending on
the label) of the person you want to search for.

4  Click the down arrow next to the “Look in” field to select the
directory in which to search.

I mportant! For information on adding or editing directories, see
[Setting Up and Editing Directories [6-25] |

5 Open the File menu and select Search.
Result:

The search displays the entries in the detailed view, which lists
the entry’s name, number, email, organization, and city.

ES post - gaddis HE 3

File Edit “iew Phone BEEEg=aags

Mame: I gaddid ® Name Icompan_l,l LDAP "l |@ |
Phoare Hurnber - — -

I armne / | i Ernail &ddress il | Organization | City
Gaddis. Graham James % | ~rrrooooscoor——arahamaddiz@ comparny. b almesbur
Gaddiz, Laura % laddiz{E compary. com Maperville
Gaddiz, Olga % +1 B08 555 2338 | oaddis@ company. com t arlbaraug
Gaddis, Peter % +1 508 555 2456 | paddiz@ company. com r arlboroug
Gaddiz. Sharon % +1 303 555 3898 | saddiz® company.com Westmingh
Gaddy, George Henry +1 402 555 4521 Omaha
Gaddy, John H +1 614586 6873 | jhaddison(@ company.con Columbug
Gaddy, RAYMOMD raddizonia compary. com
Gaddy, Sharran D +1 B30 713 8944 | addizond@ company. con Wapervill
1| | ©
Edit information for public directary. i
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6 Once the entry is found, you can select it to call. You can also copy
and save an entry from the Public Directory into the IP Agent Phone
Directory.

Important! When an entry is added to the phone directory, the name,
phone and email fields are automatically entered.
END OF STEPS

Setting Up and Editing  To search a public directory, you must perform the appropriate
Directories  directory administration. Follow these steps:

1 To begin the directory administration, in the Search Public Directory
dialog box do one of the following:

e  Click the Directory button, or
. Select Accounts from the Edit menu.

E¥ Search Public Directory

Fil=: W18 “fiew Phone SearchFor

Mumt Accounts... | @| Look in:lcompan_l,l LDAF "l | @ |
Result:

The Directory Setup dialog box appears.

Ed Directory Setup

company LODAP Add

Bemove
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2 Inthe Directory Setup dialog box, do one of the following:
*  Click the Add button to add a directory to be set up.

*  Highlight a directory and click the Remove button to remove a
directory.

*  Click Properties to add or edit directory information.
Result:

The Directory Properties dialog box appears.

B4 Directory Properties

General | Advanced I

BT iTe s company LDAP

Server Address; IIdap-cnmpany.n::Dm

Logor; I

Faszword: I

Search Root; Il:uu=|:|en|:|le, aA=COMpany. com

QF. Cancel

3 Inthe Genera tab, enter or edit the following information about the
specified directory:
*  Description
Server (Public) address
*  Search Root

Important! Logon and Password requirements are dependent on the
database you are accessing.
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4  Click the Advanced tab.

B3 Directory Properties

General ﬁdvancedl

Fart: IE

Search Timeout: |2I:II:I

bax. Entries Fetumed: |1|:|

QE. Cancel

5 Inthe Advanced tab, enter or edit the following:
 Port
*  Search Time-out
Maximum Entries Returned for the Public Directory

Important! These settings are determined by the administrators of the
database you are accessing.

6 When finished making your entries, click OK to exit the Directory
Properties dialog box and return to the Search Public Directory
window.

Result:
The directory you added has now been added to the directory
list in the Search Public Directory dialog box. You can now

select this directory from the “Look in” list box.
END OF STEPS
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14 Performing Administrative Tasks

Overview

Purpose  Performing Administrative Tasks is written for supervisors and system
administrators who are responsible for setting up and maintaining
computer configurations and options that affect the operation of the IP
Agent software.

Performing Administrative Tasks includes the following topics:
« |Administering Dialing Properties [7-2]|

« [Administering Options [7-5]|

« |Administering Screen Pops [7-11]|

« |Administering ACD [7-22]|

585-215-110 Lucent Technologies 7-1
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Administering Dialing Properties

Introduction

Administering Dialing Properties explains when and how numbers
are formatted and dialed.

To administer dialing properties, do the following:

1.

On the Windows® taskbar, select Start on the taskbar and then
click Settings and Control Panel. The Control Panel appears.

In the Control Panel dialog box, select Telephony. The Dialing
Properties window appears.

In the Dialing Properties window (see|example below) | enter the
information asked for in the fields. Refer to Microsoft® Windows
Help for information on what to enter in the Dialing Properties
window.

Tip: Remember that these are the dialing properties for the switch
you are connected to, not your home phone.

These are the minimum fields that you need to fill in:

e Country/region area code (Some countries will need to set
area code rules.)

. For local calls, dial

Lucent Technologies 585-215-110
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*  For long distance calls, dia (usualy the same number as the
local access number.)

Dialing Properties EE
My Locations | Telephony Drivers I

| am dialing from:

b Mew... | HEemmve |
| am in this countryregion; Area code;
ILIniteu:I States of America j |3|:|3 Area Code Rules. ..

—%hen dialing from here

To access an outzide line:

For local callz, dial I

For long distance callz, dial I

[ To dizable call waiting, dial: I vI

Dial using: % Tone dial € Pulse dial

™ For long distance calls, use thiz caling card:

|None [Direct Dial) | Caling Card... |

(] I Cancel i

When you dia a number from IP Agent, the number will be formatted
based on the information configured on the computer in the Dialing
Properties dialog.

For example, if your configuration is as follows:

* Area Code: 303.

» To access an outside line for local calls, dial 9.

* To access an outside line for long-distance call, dial 9.

585-215-110 Lucent Technologies 7-3

Issue 1, March 2000



Administering Dialing Properties

Performing Administrative Tasks

The following table shows how numbers are formatted and dialed:

User Enters
5551212
85571
8005551212
61295551212
800flowers
95551212
918005551212

Formatted Number
+1 (303) 555-1212
85571

+1 (800) 555-1212
+6 (129) 555-1212
+1 (800) FLOWERS
95551212
918005551212

Number Dialed

9 555-1212

85571

9 1 800 555-1212

9 011 6 129 555-1212
9 1 800 356-9377
95551212
918005551212

Lucent Technologies
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Administering Options

Scenario

The supervisor or system administrator is responsible for
administering the options on all remote computers. To do this, the
supervisor first sets up the options on a computer the way he or she
would like to have the options administered on all remote computers.
Next, he or she administers the necessary screen pops and sets up the
actions for each screen pop.

After setting up all the options, the supervisor exports the
configuration information to a disk and distributes it to each remote
agent, along with the IP Agent compact disk, or he or she exports the
configuration information to a shared network directory. After the
agent installs IP Agent on his home computer, he can import the
configuration information from the appropriate location. The IP
Agent’s computer will then contain the options and configuration that
the supervisor wanted.

The options exported and imported will include al the options
displayed on the Options dialog box except the “Voice Message
Directory Entry” option. The configuration information will include all
administered call events along with the DDE or Web Page triggers. It
will aso include Public Directory administration and the DEFINITY®
ECS name or IP address.

The supervisor can elect to disable the program administration so that
the agents cannot change the program administration on their
computers.

Administrable Options

The Options dialog lets you administer the following options:

* Alwaysdisplay IP Agent on top of other windows?

* Display an “Answer” icon in the system tray when the phone is
ringing?

* Display call display information using "Eurofont” font?

* Display call display information using "Kanafont” font?

* Display call display information with this font size?

* Display the main window when the phone is ringing?

» Display tooltips for toolbars?

* Enable TAPI assisted dialing?

*  Flash the window’s title bar when the phone is ringing?

585-215-110
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* Logincoming calls.

* Log outgoing calls.

*  Number of days to keep calls in the call log?
*  Number of digitsin company extensions?

*  Number of recent calls that will be displayed by “Recent Call”
popup menu?

*  Phone directory entry for voice messages?

* Play derting sound using the computer’s internal speaker?
» Play derting sound using the computer’s sound card?
Prompt for Agent ID and Password during Agent Login?

Setting Options  To administer options, follow these steps:

1 From the IP Agent menu bar, open the Tools menu and select Options.
Result:

The Options dialog box appears.

& Options |

Settings | Generall

Dizplay tooltips for toolbars.
Dizplay letterz on the dialpad
O Use Japanese font on call dizplay.
Frompt for agent [0 and paszword during agent login.
=P Ircoming Call:
Dizplay Answer icon for incoming calls.
Flazh window for incoming calls.
Dizplay the main window for incoming calls.
{3 Call Alerting
Q) Do not play alerting sound,
Q) Play alerting zound uzing sound card,
@ Play aleting zound uzing internal speaker. ;I

k. I Cancel | e 1] |
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2

3

4

5

6

Performing Administrative Tasks

In the Settings tab, click on an option to enable or disable it.

If you want to clear al call history entries, you can do it by clicking
the Clear History button.

To make Call History and other general changes, select General.

Result:
The General tab appears.

S ~ |

Seftings General |

Call Higtary

Dayz to keep callz in log: - Clear Higtary |

Murmber of recent callz dizplayed:

MHumber of digitz in company extenzions:

To activate Caller ID blocking, dial:

il lul ulul

Call display font size:

Yoice Message: IIH ALDE

| )4 I Cancel | Spply

In the Genera tab, enter the appropriate changes.

When finished, click OK to activate the options.

END OF STEPS

585-215-110
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To export these settings to a disk or shared network directory,
follow these steps:

From the IP Agent menu bar, open the File menu and select Export
Settings.
Result:
The Save As dialog box appears.

Save i Ia Centretu [P Agent j ﬁl

] Paszagew’ay

@ Options. reg

@ OptianzBill reg

@ Optionslane.req

8] DptionsSkill reg

3] OptionsSkill2.reg

File name: Im Save I

Save as lwpe; IHegistratinn Filesz [*.req) j Cancel |

[ Open as read-only
In the Save As dialog box, enter the following fields (or accept the
defaults):
»  Save in—navigate to the drive and folder where you want to save
the file.
*  File name—enter the name of the file.
*  Save as type—select the type of file.
Click “Open as read-only” if you do not want the agents updating the
file.
Select Save to save the file to the destination folder you specified.
Lucent Technologies 585-215-110
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Result:

The agent can now import the configuration information from
the appropriate location.

END OF STEPS

Importing the Settings  The agent can now import the configuration information from a
disk or shared network directory to his or her computer. To do
so, follow these steps:

1 From the IP Agent menu bar, open the File menu and select Import
Settings.

Result:

The Open dialog box appears.

[ - ]
Loak jr: Ia Centret/u 1P Agent j EI

] Pazzageiw ay
@ Optionz.reg

@ OptionsBill.reg
@ Optionz) ane.req
18 ] OptionsSkill reg
3 ] OptionsSkill2.reg

File name:

tiors Open I
Filez of type: IHegistratiDn Filez [*.1eq) ﬂ Cancel |

[T Open as read-only

2 Inthe Open dialog box, select the file you want to import.

585-215-110 Lucent Technologies 7-9
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Result:

If al goes well, the program informs you that the configuration
information has been successfully entered into the registry.

Registiy Editor [ %]

® Information in C:\Program FileshLucentiCentrelfu IP AgenthOptions.reg has been successfully entered inta the registry.

3 Click OK or press the Enter key.

Result:

The options your supervisor has set up for your station have
been successfully imported.

END OF STEPS

Lucent Technologies 585-215-110
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Introduction

Screen pops are used to trigger application actions. Screen pops can

trigger either a Dynamic Data Exchange (DDE) or an HTML event.

To see a detailed view of call events, select the View command in the
Screen Pops dialog box. The detailed view displays the entry’s
description, call type, call source, event trigger, and trigger
description. You can add, edit, or delete a screen pop.

DDE Screen Pops

You can administer information about calls that will generate DDE

screen pops in the Screen Pops dialog box. To administer DDE screen
pops, do the following:

1. IntheIPAgent main menu, select Tools and then select Screen
Pops. The Screen Pops dialog box appears.

2. From the Screen Pops menu bar, select the item you want to use;
for example, “Incoming Ringing.”
3. To add properties, click the New button. Then go to

[Properties [7-12] |

* Screen Pops M= E
File  Edit Wiew

x|

Trigger | Type | Screen Pop 4 |

|ncoming Answered HTHML | GetAccount Info

I | ricoming Ringing Spread Sheet H:

Qutgoing Connected HTHML | GetAccount Info

Feady o
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The following table lists the Screen Pops menu commands and a
description of each command.

Menu
Com-
mand

File

Edit

View

Submenu
Command
and
Buttons

New

=1

Close

Delete

Pl

Properties

Description

Displays an empty Properties window.

Closes the Screen Pops window.

Deletes the highlighted entry in the
Screen Pops window.

Displays the Properties window for the
line item selected in the Screen Pops
window.

DDE Properties  The Properties dialog box lets you add or edit properties that will be
used to initiate a screen pop.

1. To add properties, select the New button in the Screen Pops
dialog box. The Properties dialog box appears.

2. Complete the fields in the Properties dialog box. See the[tabld
below for descriptions of the fields.
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3. Click Setup to add, edit or remove DDE triggers. Then go to
[DDE Screen Pops Setup [7-14] )

Properties for Incoming Ringing |

Ciescriptiar: IIncDming Ringing

Call Type:  * |ncoming " Outgaing
Call State: Iﬁ.ngwered j
Trigger thiz action:
DDE =l |5pread Sheet #4 7]
0K Cancel

The following table gives a description of al of the fields in the
Properties dialog box.

Field Action

Description Enter several words that describe this trigger
event.

Call Type Activate this event for incoming or outgoing call.

Call State Indicate the state of the call. To do so, enter one

of the following:

¢ Ringing (incoming)

* Answered (incoming)

¢ Released (incoming and outgoing)

» Call Missed (incoming)

» Connected (outgoing)
Trigger this Activate to trigger. Do one of the following:
action « Activate a DDE event.

¢ Activate an HTML event.
Unnamed list Presents a list of DDE Trigger Setups or presents

box alist of HTML Trigger Setups, depending on
which is selected.

Setup Button

585-215-110 Lucent Technologies 7-13
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Field Action
DDE selected Displays the DDE Screen Pops Setup screen.
HTML selected Displays the HTML Screen Pops Setup screen.

OK button Makes the data in the Properties screen active
and returns you to the Screen Pops window.

Cancel Button Ignores the data in the Properties screen and
returns you to the Screen Pops window.

DDE Screen Pops Setup  The Screen Pops Setup dialog box lets you add, edit or remove DDE
triggers.

1. Click Setup in the Properties box to display the Screen Pops
Setup dialog box.

2. Select Properties or Add to display the DDE Screen Pop
Properties dialog box. Then go to[DDE Screen Pops Properties

Screen Pops Setup E3 |

Spread Sheet H4

Remove

Froperties

Cloze |

This table gives a description of the buttons on the Screen Pops Setup

dialog box.
Button Description
Add Displays a blank Screen Pop Properties screen.
Remove Removes an entry if it is highlighted.
7-14 Lucent Technologies 585-215-110
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DDE Screen Pops
Properties
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Button Description

Properties Displays the Screen Pop Properties screen with the
properties of the Trigger description selected.

Close Returns you to the first Properties screen and
ignores any changes made in the Screen Pops Setup.

The DDE Screen Pop Properties dialog lets you describe the trigger,
indicate an application, enter a command, or enter other information
that would help to trigger a DDE event.

1. You clicked the Properties button in the Screen Pops Setup dialog
box to display the DDE Screen Pop Properties screen.

2. Complete the fields in the DDE Screen Pop Properties dialog
box. See the table below for descriptions of the fields.

3. To test the connection to the DDE server, press the Test button.
After the connection is established, you can execute commands
or poke data. The Status window will display DDE status
information while you are testing the trigger.

DDE Screen Pop Properties E3
Dezcription; SR =g

Topic: Isystem Test |

Service: IEHCE|

% Exectie: . Poke:
Command: IC'DEH Erecute |
Item: I Dgta:l Eake |
Data Format:  |Mame: #n, Mumber: %d. Prompted Digits: #p

Murnber Length: IB _I;

Statuz: |Initializing service ;I
Service running

Cancel

o]
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In the DDE Screen Pop Properties dialog box, enter any of the

following:

Field Description

Description Short description of the trigger.

Service A string expression identifying an application that
can participate in a DDE conversation. Usually, the
application argument is the name of an .exe file

(without the .exe extension) for a Windows-based application,
such as Microsoft Access.

Topic A string expression that is the name of a topic
recognized by the application argument. This will be
the second parameter of the DDElInitiate() function.

Test To test the connection to the DDE server, press the
Test button. The Status window will display DDE
status information while you are testing the trigger.

DDE IP Agent can send information using the "execute” or

Function the "poke” command.

Command A string expression specifying a command
recognized by the server application. This field is
only used for the "Execute” DDE command. The
string will only be changed to input caller
information. The syntax must match the syntax
required by the DDE program. For example, if
embedded quotes must be quoted (e.g. "name =
"Lang"""), then the string must be entered that way.

Item A string expression that’s the name of a data item
recognized by the topic specified by the DDElnitiate
function. This field is only used for the "Poke" DDE
command.

Data A string containing the data to be supplied to the
other application. This field is only used for the
"Poke" DDE command.

Data Format  The format string of the database.

Number Number length of the data.

Length

Status Status of the data.

585-215-110
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To have caller information inserted in the command or data fields,
enter the appropriate data format:

e Party number - %D
*  Party name - %N
e  Cdl prompting digits (incoming calls only) - %P

You can administer information about calls that will generate HTML
screen pops in the Screen Pops dialog box. To administer HTML
screen pops, do the following:

1. IntheIP Agent main menu, select Tools and then select Screen
Pops. The Screen Pops dialog box appears.

2. From the Screen Pops menu bar, select the item you want to use;
for example, Outgoing Connected.

3. To add properties, click the New button. Then go to[HTML
[Properties [7-18] |

= Screen Pops M= E
File  Edit iew

x|

Trigger | Type | Screen Pop 4 |

|ncoming Answered HTHML | GetAccount Info

Incoming Ringing DDE Spread Sheet #4

Cutgoing Connected et Account Info

Feady o
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This table lists the Screen Pops menu commands and a description of
each command.

Menu Submenu Description

Com- Command

mand and Buttons

File New Displays an empty Properties window.

Close Closes the Screen Pops window.

Edit Delete Deletes the highlighted entry in the Screen
= Pops window.

F

View Properties Displays the Properties window for the
line item selected in the Screen Pops
window.

HTML Properties  The Screen Pops Properties dialog box lets you add or edit properties
that will be used to initiate a screen pop.

1. To add properties, select the New button in the Screen Pops
dialog box. The Properties dialog box appears.

2. Complete the fields in the Properties dialog box. For information
on these fields, see|DDE Screen Pops Properties [7-15]

7-18 Lucent Technologies 585-215-110
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3. Click Setup to add, edit or remove HTML triggers. Then go to
HTML Screen Pops Setup [7-19].

Properties for Outgoing Connected |

Ciescriptiar: Il:lutguing Caonnected

Call Type: ¢ Incoming & Qutgaing
Call State: IEnnnected j

Trigger thiz action:
|7|HTML j IGetﬁl'-.n:n:DuntInfn:n j

k. Cancel

HTML Screen Pops Setup  The Screen Pops Setup dialog box lets you add, edit or remove
HTML triggers.

1. Click Setup in the Properties box to display the Screen Pops
Setup dialog box.

2. Select Properties or Add to display the HTML Screen Pop
Properties dialog box. Then go to|[HTML Screen Pop Propertied

Screen Popz Setup |
Get Account Info
Remove
Properties
Cloze |
585-215-110 Lucent Technologies 7-19
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This table contains a list of HTML setup descriptions and four

buttons.

Button Description

Add Displays a blank HTML Screen Pop Properties
screen.

Remove Removes an entry if it is highlighted

Properties Displays the HTML Screen Pop Properties screen
with the properties of the Trigger description
selected.

Close Returns you to the first Properties screen and
ignores any changes made in the HTML Trigger
Setup.

HTML Screen Pop  The HTML Screen Pop Properties dialog lets you describe the trigger,
Properties  indicate an application, enter a command, or enter other information
that would help to trigger an HTML event.

1. You clicked the Properties button in the Screen Pops Setup dialog
box to display the HTML Screen Pop Properties screen.

2. Complete the fields in the HTML Screen Pop Properties dialog
box. See the(table below| for descriptions of the fields.

3. After the connection is established, you can pass caller
information to the HTML trigger by including the appropriate
data format string in the command, data, or URL field.

HTML Screen Pop Properties Ed

Descriphon: |EfE Ty glgs

URL: Ihttp:Hu:umpan_l,l.u:u:um;"u:gi-bim’query 7 tel=3d Test |

Mame: #n, Mumber: %d. Prompted Digits: Zp

Mumber Length: |5 _IQ
OF. I Cancel

Data Format;:
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In the HTML Screen Pop Properties dialog box, enter any of the
following:

Field Description
Description A short description of the trigger.
URL The URL string of the Web page.

Test To test the connection to the HTML server, press the
Test button. The Status window will display HTML
status information while you are testing the trigger.

Data The format string of the database.
Number The number length of the data
Length
L]
585-215-110 Lucent Technologies 7-21
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Administering ACD

Introduction

Administering ACD explains how to set up Automatic Call
Distribution (ACD) for IP Agent. See|Supported Phone Sets [1-5]| for
a list of phone sets that Lucent Technologies supports for use with IP
Agent.

For IP Agent to work properly, you will need as a minimum the
following buttons: Release, Auto-In or Manual-In, and an AUX Work
with a null Reason Code button. AUX buttons are displayed in the
order they are administered on the switch. The first administered AUX
button will be used if you click the AUX button or use the shortcut
key, Control-A.

For more information on button layout for CALLMASTER® VI, see
the CentreVu® Version 1.0 Installation and Administration guide
(585-215-816).

Lucent Technologies 585-215-110
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Doing the Setup
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want. Follow these steps:

To begin, set up one IP Agent application with the options you

window.

Open the Tools menu and select Options to display the Options

T |

Settings | General I

O always dizplay the main window on top.
Digplay tooltips for toolbars.
Dizplay letters on the dialpad
[ UszeJapanese font an call display.
Frompt for agent 1D and pazsword during agent login,
=¥ Incoming Calls
Digplay Answer icon for incoming calls.
Flazh window for incoming calls.
Dizplay the main windaw for incoming calls.
-3+ Call Alerting
O Do not play alerting sound.
O Play alerting sound using zound card.
=) Play alerting sound using interal speaker.

O Cancel |

Al

Tip: SeelAdministering Options [7-5]| for more information.

2 Do one of the following:

* If your station or agent login is administered as Auto-Answe,
click the Auto-Answer option to enable it. Then click OK, and

reboot your computer.

* |If your station or agent login is not administered as Auto-Answer,

click Cancdl.

585-215-110
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Register the phone. Then change the button names you want to

change in the Phone Features dialog box.

¥ Phone Features M= E3

=--f38 ALK/ Reazon Codes

----- O Lunch

----- O Dinner

----- O Coffes break

----- O Auwiliary work bMode 3
----- O Avwilian Work Mode 4
----- O Avwiiary Work bMode &
----- O Auwiliary work Mode &
----- O Avilian Work Mode 7
EIF'|__—5| Stroke Countz

----- O Stroke Count 0

----- O Stroke Count 1

----- O Stroke Count 2

----- O Stroke Count 3

----- O Stroke Count 4

----- O Stroke Count &

----- O Stroke Count &

----- O Stroke Count ¥

----- O Stroke Count 8

----- O Stroke Count 3

----- B Manual-ln Mode
----- O Autarmaitic Dial 1
----- 1 Autnmaitic: Nial 2

A&dd to Perzonal List

r
—

|

Tip: See|Using Phone Feature Options [6-15]| for more information.

To change a button label, right click once on the label then select
Rename. Type the new name over the old name.

Important! If you want to put a subset of the buttons in the Personal
Features dialog box, click once on the button and then click the Add

to Persona List button.

Lucent Technologies
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To disallow the changing of the options and button names, use
Windows regedit.exe command to go to make the following changes to
the registry. Go to:

HKEY_CURRENT _USER/Software/Lucent/CentreVu |P
Agent/Config/Options/Edit Options.

To save the registry settings to a server, select File and then select
Export Settings. To download the registry settings to the next
computer, select File and then select Import Settings.

If you want to copy the Phone Directory files to another computer,
first administer all the entries desired into the Phone Directory. Next,
clear the Call History log.

The phone directory is stored in the following file:
ProgramFiles/Lucent/CentreVu 1P Agent/agent.mdb. Copy the
agent.mdb file to each computer after IP Agent is installed.

Set up the Windows telephony dialing for the dial plan of the
DEFINITY ECS. (The call back number does not use the telephony
settings.)

Tip: See|Administering Dialing Properties [7-2]| for more information.

If the modem is on the PSTN (Public Switched Telephone Network),
set the dialup network properties to not use the Windows dialing
properties.

Make sure that the following DEFINITY ECS Administration fields
are set for the station you plan to take over with IP Agent:

*  “IP Softphone” is “y”
o “multimedia mode” is “enhanced”
e “service link mode” is “permanent” or “as needed”

585-215-110
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If you want an emergency backup for local agents, administer
auto-answer for the station and not for the agent ID. You will need to
administer VOA (VDN of Origin Announcement) for the analog set.
Then, if you manually log in to the analog set, you can take calls.

One DEFINITY C-LAN card can handle 500 dua connect |P Agents.
If you have more than that, you will need to assign different C-LAN
IP addresses. A DNS (Domain Naming System) server could assign
these automatically.

Important! The “automatically start CentreVu IP Agent when
Windows is started” option during installation is not very useful if you
are using a dial-up connection with dynamic |P addresses.

END OF STEPS
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8  Troubleshooting

Overview

Purpose  Troubleshooting provides information that can assist you in solving
problems you might encounter when installing or running 1P Agent.
This information does not include DEFINITY® ECS troubleshooting
messages. You can find DEFINITY ECS troubleshooting messages on
the CD-ROM, DEFINITY ECS Release 8.2 Documentation CD
(555-233-813).

Troubleshooting includes the following topics:
« [Installation Problems [8-2]|

« [Registering and Login Problems [8-3]|

«  [Cannot Make or Receive Calls [8-10]|

« [Active Call Issues [8-13]|

+ [Logging Out and Unregistering [8-15]

585-215-110 Lucent Technologies 8-1
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Troubleshooting

|nstallation Problems

Introduction

The information below presents some common problems that you
might encounter while installing IP Agent.

Problem

When installing CentreVu® 1P Agent on Windows NT®, a message box
appears displaying the following message: “The OLE system files are
in-use and cannot be updated. This installation will restart Windows®
to update the OLE system. You must run this Setup again after
Windows restarts to complete the installation.” The installation then
cancels.

Solution

Restart the Windows system and then run setup.exe.
Problem

Your PC does not have enough memory to install 1P Agent.
Solution

IP Agent requires the following:

*  Hard disk with at least 25MB of space available.

«  Minimum of 32MB of RAM if you are using Microsoft®
Windows NT 4.0 or Microsoft Windows NT Workstation.

Minimum of 16MB of RAM if you are using Microsoft Windows
98 or Microsoft Windows 95. If your PC does not have enough
disk space or RAM, you will need to add some.

Problem

When you are installing IP Agent, you get the following error
message: “...cannot completely install because NetMeeting is already
running.”

Solution

You need to quit the install. Open NetMeeting®. Go to “Tools...
Options.” Under the General tab, verify that “Run Netmeeting in the
background when Windows starts’ is not selected. If it is, then
de-select it. Click OK. Close NetMeeting. Go to the taskbar and right
click on NetMeeting icon to close it. Then begin the installation again.
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Registering and Login Problems

Introduction

Use the following information to help you with problems you may
encounter when registering or logging into the DEFINITY ECS.

Tip: If possible, try to register the station from another computer. If
the station can be registered, then the problem points to an issue on
the user’s computer. If the station cannot register from any computer,
then the problem points to: administration, wrong password,
corruption, network problem. If all else fails, try uninstalling and
reinstalling 1P Agent.

Error Message
Failed to open view. Calls will not be logged.
Solution

This message box appears if there is a problem with the database for
the Active Log. The Active Log database may be either missing or
corrupted.

Problem
You are missing a .DLL during an install from the server.
Solution

Make sure your view of Windows Explorer shows al files when the
files are copied over to the server, and that the directory is mapped to
alocal drive.

Problem
You set the auto-answer option, but it does not work.
Solution

If you have not rebooted after setting the auto-answer option,
auto-answer will not work. You will be logged off right after you
logged in. Reboot your computer.

Problem
You get the “switch is busy” message during registration.
Solution

Check that TTI is enabled. TTI gets turned off during software
upgrade.

585-215-110
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Registering and Login Problems

Troubleshooting

Problem
Registration will not work.
Solution

If you have duplicate addresses in your network, registration will fail.
Delete duplicate addresses.

Error Message

This version of the registration application is incompatible with the
DEFINITY DEFINITY ECS software. Call the Lucent Helpline or your
Lucent Technologies authorized dealer to obtain the latest version of
the registration application.

Solution

The software version of the endpoint software is not compatible with
the software version running on the DEFINITY DEFINITY ECS to
which this endpoint is attempting to register. Assuming that the
DEFINITY DEFINITY ECS is running the latest software version,
obtain the latest software version of the endpoint software and
re-register it. If the endpoint is already running the latest software
version, then the DEFINITY DEFINITY ECS is not running the latest
DEFINITY DEFINITY software version. Either obtain an older version
of the endpoint software version, or upgrade the DEFINITY
DEFINITY ECS to the latest software version

Error Message

Your login attempt was unsuccessful due to one or both of the
following conditions:

. You entered an invalid extension.
*  You entered an invalid password.
Solution

Re-enter your extension and/or password and then choose the Login
button.

1. For the extension for which you are registering, verify that the
extension is administered on the DEFINITY ECS associated with
the IP address you specified on the DEFINITY® Login screen.

2. If this extension is administered, verify that the password
specified on the DEFINITY® Login screen is the same password
administered on Page 1 of the Station form in the Security Code
field.
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Troubleshooting

Error Message

Either the call control application or the voice connection destination
you have selected is not compatible with the extension you have
specified or your extension is not properly administered. Please
contact your system administrator.

Solution

Verify the following:

If you are registering using the Roadwarrior or Telecommuter
configurations, verify on the DEFINITY® Login screen that the
extension number which with you are registering is administered
as avalid DEFINITY IP® Solutions set type on the Station form,
page 1. Valid IP Solutions set types can be found in the release
letter for 1P Agent. Note that BRI sets cannot be IP Agents. If a
station is administered as a BRI set, the “IP Agent?’ field is not
visible on the station form.

If you are registering using the Roadwarrior or Telecommuter
configurations, verify on the station form, page 1 that the IP
Agent field = Yes for the extension with which you are
registering.

If you are registering using R/T, verify on the DEFINITY®
Login screen on the endpoint that the call control application
selected is “CentreVu IP Agent.”

If you are registering using R, verify that on the Station form,
page 1, an administered H.323 extension is entered in the “Media
Complex Extension” field 5.

If you are registering using Native, verify on the DEFINITY®
Login screen that the extension number with which you are
registering is administered as an H.323 set type on the station
form, page 1.6.
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Troubleshooting

» If you are registering using Native, verify on the SAT using the
“list multimedia ip-softphones” command, that the extension with
which you are registering is not listed as a "Media Complex
Extension” for any other station. If it is, select either another
H.323 extension, or go to the station form for the station listed,
and blank the Media Complex Extension field on page 1.

* If the extension with which you are registering has a Data
Module, you cannot register using that extension. Verify on the
station form, page 1, that Data Module = N. Note that set types
with integrated data mods (for example, 510, 515, and 7407D)
cannot be DEFINITY IP Solutions endpoints.

Error Message

The extension to which you are trying to log in is associated with a
telephone or another Softphone. Select the OK button to override that
association; otherwise, select the Cancel button.

Solution

This is an informative message, not an error message. The extension
to which you are registering is either bound to a physical set or
another endpoint is currently registered using the same extension. This
message is given to tell the user that by registering with this
extension, the telephone already bound to the extension will be taken
out of service. The DCP set will become a TTI port. Selecting OK
will alow the registration to proceed.

Error Message

A login attempt was unsuccessful due to one of the following
conditions:

*  The network or server is experiencing problems.

*  You entered an invalid IP address or node name. Re-enter your
IP address or node name and then choose the login button.

Solution

This message is given when the endpoint cannot communicate with
the DEFINITY ECS. The endpoint sent the login request to the
DEFINITY ECS, but does not receive a reply back. The endpoint may
not be communicating with the DEFINITY ECS due to entering the
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Registering and Login Problems

Troubleshooting

incorrect |P address or node name for the DEFINITY ECS on the
DEFINITY® Login screen.

Verify that the IP address or node name is the correct address or
name for the C-LAN board on the DEFINITY ECS with which
the extension is administered.

It may also be that the DEFINITY ECS is having problems and is
not able to receive messages from the endpoint or send messages
to the endpoint.

Verify that the endpoint can ping the DEFINITY C-LAN board
and that the DEFINITY ECS can ping the endpoint.
Additionally, the network may be experiencing problems,
including congestion, which prevent packets from being received
by the DEFINITY ECS or by the endpoint.

Error Message

The system is currently busy and is unable to log you in at this time.
Please try again in a few minutes. If the problem continues, please
contact your system administrator.

Solution

Do any of the following:

Verify on the system feature form page 2 that terminal translation
initialization (TTI) enabled =Y.
Verify that a "save trandation” is not being performed on the

DEFINITY ECS. If it is, wait until the transaction is complete
and then re-register.

Verify that system administration work is not being performed on
the extension for which you are registering. That is, verify that
no one is currently modifying the station form of the extension
for which you are registering.

Error Message

You have been logged off by the server. DEFINITY IP Agent
application will be shutting down. Please wait....
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Solution

This is an informative message, not an error message. The endpoint
was unregistered by the DEFINITY as a result of a user action, such
as.

*  While this endpoint was successfully registered, another endpoint
registered using the same extension number. The user attempting
the second registration was informed that there was an existing
telephone or softphone associated with this extension. The user
then chose to unregister this endpoint and register with another
endpoint.

* A busy-release was performed on the DEFINITY ECS for the
extension number of the registered user.

Error Message

Your communication to the server was lost. The server or network
may be down or experiencing problems. Choose the OK button to
return to the log in window and log in again.

Solution

Communication between the DEFINITY ECS and the endpoint was
severed. There are numerous reason why this may occur. This cause
may be in the network, in the endpoint, or in the DEFINITY ECS.

Error Message

An error was identified in the DEFINITY® Login Application.
Choosing the OK button will alow you to exit the application. Try to
log in again. If the error continues, call the Lucent Helpline or your
Lucent Technologies authorized deder.

Solution
Do any of the following:

e Verify that users set type is not a non-display set type. A
workaround is to administer the station set type as one with a
display. A 7410+ should be administered as a 7410D. A 603D1
should be administered as a 603E1

*  Record the processing errors on the DEFINITY that occurred
during this registration and report them to the appropriate Lucent
staff.

Error Message
Login session did not shut down completely. Please wait and try to
log in again
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Solution

It takes 1-5 minutes for previous IP Agent session to shut down. If
you attempted another log in during that time frame, wait and try to
log in after 5 minutes. If you are still receiving this message after 5
minutes, reboot the PC.

Error Message

There is not enough memory available to run this application. Please
close some other applications or restart Windows and try again.

Solution

Close any other applications that may be running and then restart
DEFINITY IP Agent. Check system and station administration.

The station administration station form should contain the following:

* Page 1. Compatible DCP Set type: Currently 8405B, 8410D,
8405D, 8411D, CALLMASTER® 1l 602, 6408+, 8405D+,
8405B+, 8411B, 6408D, 8405B+, 8405D+, 8434DX,
CALLMASTER Il 603E, 6408D+, CALLMASTER IV 603F,
8410B, CALLMASTER |11, 6416D+, CALLMASTER V 607,
CALLMASTERVI 606

. Page 1: IPAgent = Y

 Page 1. COS corresponds to a COS with PSA =Y
 Page 1. Security Code: has some value

. Page 1: IPAgent =Y

 Page 2: H.320 Conversion = Y

 Page 2: Service Link Mode = permanent or as-needed
»  Page 2: Multimedia Mode = enhanced
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Cannot Make or Receive Calls

Introduction

Use the following information to help you if you are logged in but
cannot make or receive calls.

Problem

DEFINITY IP Agent starts successfully, but the following message is
displayed in the Call Status area at the bottom of the CentreVu IP
Agent window: “Telephony is not available.”

Solution

Do the following:

1. Log off the DEFINITY ECS and then try logging into the
DEFINITY ECS again. If you are unable to log in and make
calls, reboot your PC and then try logging in again.

2. If you are dtill unable to log in to the DEFINITY ECS, uninstall
and re-install the CentreVu 1P Agent application and then try
logging in again.

Problem

When trying to originate a call, after clicking the “Dial Now” button,

a message box saying “This action cannot be completed at this time’
is displayed.

Also, when receiving a call, after clicking “Answer,” the call is

dropped.

Solution

There are two possible solutions to this problem:

*  Veify switch ARS, station permissions (COS, COR).

» If this happens when you are using telecommuter, the Service
Link mode on the station form is set to “as-needed,” and you are
immediately trying to make another call after hanging up, it is
because the service link to the station needs to be torn down.
This can take up to ten seconds. You can change the Service

Link mode to “permanent” and then the service link will not
need to be torn down between calls.

Problem

When you place a call, you are connected to the wrong destination
(that is, wrong telephone number).
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Solution

Make sure the IP Agent dialing properties are set up properly and
match the area code of your DEFINITY ECS. Click on View: Dialing
Properties.

Problem

CentreVu 1P Agent does not pop-up; neither does Phone Directory or
Notes (if options are set for these applications to pop on answer).
There are two possible solutions to this problem:

*  Veify that IP Agent administration is set for “Show IP Agent on
Ringing,” “Show Phone Directory on Answer,” or “Show Notes
Screen on Answer.” Verify by clicking Properties. Preferences.

Solution

These types of calls will not cause IP Agent to pop: auto-answer, call
pickup, and answer back for paging parked calls. Log Manager will
show these calls as outgoing calls.

Problem

When IP Agent starts, a message box appears displaying this message:
“There is not enough memory available to run this application. Please
close some other applications or restart Windows and try again.”

Solution

Close any other applications that may be running and then restart |P
Agent.

Problem

IP Agent starts successfully, but the following message is displayed in
the Call Status area at the bottom of the IP Agent window:
“Telephony is not available.”

Solution

Right-click the mouse on the Incoming Call Notifier icon in the
system tray to determine whether the link to the DEFINITY ECS is
down.
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Do one of the following:

* If thelink to the DEFINITY ECS is down, try logging into the
DEFINITY ECS again.

* |If thelink to the DEFINITY ECS is up, IP Agent may be using
the wrong service provider. IP Agent should be using the
DEFINITY/Line service provider.

To verify that IP Agent is using the DEFINITY/Line service
provider, perform the following steps:

1.

Problem

From the Options menu, choose Change Telephony Provider.
The Connect Using dialog box appears.

In the Line box, choose DEFINITY/Line.

In the Address box, choose the address for the Telephony
Provider.

When finished, choose the OK button.
A message box appears, prompting you to restart 1P Agent
for the changes to take effect.

Choose the OK button.

Exit IP Agent, and then restart it to use the new Telephony
Provider.

Existing calls are not displayed in the CentreVu IP Agent window
when | start IP Agent.

Solution

Any cals that you make or receive after you start 1P Agent will
appear in the IP Agent window.
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Introduction
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This topic defines problems that might occur while you are on an
active call.

Problem

This problem is one experienced by telecommuters working at home.
The telecommuters get complaints from callers that they receive user's
residence Voice Mail or get ringback forever.

Solution
Do any of the following:

»  Telecommuters that have Voice Mail provided by their local
operating company (such as USWest Voice Mail) for their home
phone may receive the complaint that callers to their office phone
at times get their home voice mail. This can occur if the user is
on the phone (home) and a call is made to their PBX extension
number. Possible suggestion is to make sure the telecommuters
callback number isn't used except by DEFINITY ECS.

* The “ringback forever” complaint can occur if a telecommuter
has their home phone line as their callback number and they have
Call-Waiting on their home phone. The user is on the phone and
acall is made to their PBX extension and is routed to their home
phone line and will receive ringback. User should answer the call
or cancel Call-Waiting prior to “logging in,” or change their
callback number to another line, known only to the DEFINITY.

Problem

You are unable to add a participant to a conference call. You receive
this message: “The action cannot be completed.”

Solution

From the DEFINITY SAT, verify “Conference parties...” on the
“ System-parameters Features Form,” page 5, is not exceeded.

Problem

You receive the message, “Communication to the server has been lost.
You will be logged off by the server.” Your only option is to click
OK. If you click OK, you will be logged off and brought back to the
DEFINITY® Login screen.
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Solution

If you are on an active call and do not click OK, you can continue on
the call without interruption. In other words, ignore the message until
your call is completed. The problem arises when a “Keep Alive”
signal might have been lost between the PC and the DEFINITY ECS.
Reestablish the data connection and then click Cancel.

Problem

Incoming call rings and you answer it. Your talkpath is fine, but the
PC continues to ring after you’ ve answered the phone.

Solution
Reboot your PC.
Problem

After logging into IP Agent, you get the message, “Service link to
telephone not established.” You select OK and can now make and
receive calls. However, you do not receive audible alerting for
incoming calls; you only receive visual alerting on IP Agent.

Solution

This is a PC timing issue. You need to manually shut down Call
Alerting by right clicking on the icon in the windows tray. Then
manually re-open “Call Alerting from Start... Programs.. IP Agent -
Incoming Call Notifier.”

Problem

You are unable to conference or transfer.
Solution

There are two possible solutions to this problem:

*  You only have one appearance of the extension on your 1P Agent.
You must have at least two to conference or transfer.

» If other TAPI applications, such as SNAP Connection, were
running on the PC when you started |P Agent, you will not be
able to transfer. Close the other TAPI applications, open IP Agent
first, and then open the other applications.

O
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Logging Out and Unregistering

Introduction  This topic presents problems you might encounter while unregistering
or logging out of DEFINITY ECS.

Problem

Using the DCP set, you cannot make or receive calls. Dialing results
in an intercept tone.

Solution

Check if the status station shows the station is an x port. If so, the
DCP set has been taken over by IP Agent. You may still be logged
into IP Agent. Or, if you have logged out of 1P Agent, you may need
to re-associate your set by dialing the PSA Associate code, followed
by your extension number and password number.

Problem

After PSA’ing back into DCP set, the message waiting lamp does not
immediately come on.

Solution

Due to the high amount of traffic in the DEFINITY ECS, if you have
messages waiting it can take a few minutes for the lamp to come on.

Problem

After PSA’ing back into DCP set, your phone is till not working.
Solution

Two possible solutions are:

* Retry PSA.

*  Test the station with DEFINITY SAT.
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Glossary

Abbreviated Dial Feature

Allows the agent to store selected telephone numbers for quicker and easier dialing. Each
number can be a complete or partial telephone number, an extension number, or a trunk or
feature code.

ACD
See[Automatic Call Distribution.|

Active Call
A call appearance state where the voice (talk) path between two parties has been connected; for
example, a caller and an agent.

ACW
See After Call Work.

Add/Remove Programs
A Windows® feature that allows you to remove programs that have been installed on your
computer. The Add/Remove icon is found in the Control Panel dialog box.

After Call Work (ACW)
An ACD agent work mode in which agents are unavailable to receive ACD calls. Agents should
enter the ACW mode to wrap-up call-related work before the next ACD call is delivered.

Agent
A person who receives calls that are directed to a split or skill.

Agent Information Panel

This panel is displayed when there are no calls and there is status information. If the agent is
logged in, the status information also includes the agent mode (for example, Auto-In and
Manual-In).
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Agent Mode

The agent skill set associated with your EAS agent ID. To use IP Agent, you need to log into
agent mode in order to receive ACD (Automatic Call Distribution) calls. Logging into agent
mode makes the Agent toolbar available for your use.

Agent Skill

An attribute that is associated with an EAS ACD agent. Agent skills can be thought of as the
ability for an agent with a particular set of skills to handle a call that requires one of a set of
skills. An agent can be assigned up to 20 skills. The meaning of each Agent Skill is defined by
the customer. Examples of what could be considered skills are: the ability to speak a particular
language or the expertise to handle a certain product.

Agent State

A feature of agent call handling. Agent states are the different call work modes and call states
an agent can be in (logins, logouts, After Call Work, AUX, and so forth). Data about these
states is displayed in the history log.

Agent Toolbar
A toolbar that provides buttons for agent login and logout and agent modes, such as Auto-In,
Manual-In, and After Call Work.

Application Folder
A folder on the network server that holds IP Agent application software-executable files and
components.

Assist

Allows an agent to request assistance (whether on an active ACD call or not) from the split or
skill supervisor by pressing the Assist button or by putting the call on hold and dialing the
Assist feature access code, followed by the split group number. The agent must be logged into
the split.

Auto Dial
A modem feature that opens the line and dials the telephone number of another computer to
establish connection.

Auto-In
An ACD work mode. In the Auto-In mode, when an agent disconnects from a call, he or she is
automatically available to receive another ACD call.

Automatic Call Distribution (ACD)

A method of call distribution where EAS agents are placed called “skills.” An EAS agent can be
logged into up to 20 skills simultaneously. For each skill, EAS distributes calls to the agents’
voice terminals by using one of two call distribution methods. UCD or Expert Agent
Distribution (EAD).
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AutoPlay
A Windows feature that causes an application on a CD-ROM to run without any user interaction
as soon as the CD-ROM is inserted into the drive.

AUX
See Auxiliary Work.

AUX RC
See Auxiliary Reason Code.

Auxiliary Reason Code (AUX RC)

An EAS feature that enables a call center to track an agent’s time more precisely when the
agent is in the AUX state. A customer-defined numeric code that describes the reason for
entering the AUX work state, such as lunch or meetings.

Auxiliary Work (AUX ) Mode
An ACD agent work mode indicating the agent is unavailable (for example, on break or in
training) to receive an ACD call.

Available
An agent state in which the extension is able to accept an ACD call. This is a substate of
Auto-In and Manual-1n mode.

Basic Conference

Allows an agent to add parties to a call (up to five parties can be added, for a total of six on
the call). The agent selects Conference, dials the number, talks to the party, and selects
Conference again. See also|Enhanced Conference|

Basic Transfer
A transfer option that lets the agent send the present call to another phone number or extension.
The agent remains on the line until the call is answered and announces the call if desired. See

also [Enhanced Transfer| and [Unsupervised Transfer.|

Call Appearance
The call appearance is an IP Agent graphical control that provides the agent with a Call
Information Panel and a Phone Display area. See Call Information Panel and [Phone Display.|

Call Information Panel

The Call Information Panel (CIP) is a single panel (40-character display) that provides
information about a single call, such as name, call duration, status icon, and control buttons (for
example, Answer/Release and Reconnect).

Call Park
To park a call for retrieval at any extension.
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Call Pickup
To answer a call to a member of your pickup group when your voice terminal is idle.

Call Prompting
A switch feature that routes incoming calls based on information entered by the calling party,
such as an account number. The caller is prompted to select an option from those listed in an
announcement.

Connected
A trunk state in which a caller and an agent are connected on an ACD call.

Cut-Through Dialing

As a digit is entered, it is immediately dialed (as on a telephone). Cut-through dialing is
provided using the Dial Pad or by entering digits from the keyboard when focus is not on the
Number text box.

DDE
See|Dynamic Data Exchange.|

DEFINITY® ECS

DEFINITY Enterprise Communications Server. The DEFINITY ECS is a telecommunications
system that routes voice and data information between various endpoints (for example,
telephones, terminals, and computers), provides highly robust networking capabilities, includes
an extensive set of standard features (for example, Attendant Consoles, Voice Processing
Interface, Call Coverage, DS1/E1 Connectivity, Hospitality Support, Recorded Announcement,
and Trunk-to-Trunk Transfer), and provides flexibility. It also allows for the addition of optional
features and upgrades to the system as business needs change.

DEFINITY IP® Softphone
DEFINITY IP Softphone enables agents to log into their company’s DEFINITY server remotely
and make and receive telephone calls from their telephone extensions.

Delimited Text File
A file containing values separated by commas, tabs, semicolons, or other characters.

Dial Area
A frame located on the CentreVu IP Agent main window that provides dialing capabilities.

Dial Pad
A toolbar that displays the 12 characters that are on the telephone dialpad. The 12 buttons are
used to dial a number. Each character clicked is automatically sent. This is called cut-through
dialing.

GLOSSARY Lucent Technologies 585-215-110

GL-4

Issue 1, March 2000



Dial Number Button
A button (telephone icon) on the Dial Number toolbar that is used to get a dial tone (for
cut-through dialing) or to dial the digits entered in the Number text box (senderized dialing).

Dial Number Toolbar

A toolbar that provides a number text box access to the phone directory, call history, speed dial,
and recent calls list. When an agent enters a string (for example, lan) followed by Enter, a
popup menu displays with a list of the directory entries that start with that string. If the first
character of the number is a letter, the title of the field will be changed from Number to
Directory.

DNS
See Domain Naming System.

Domain
A subnetwork comprised of a group of clients and servers under the control of one security
database.

Domain Naming System (DNS)
Software that lets users locate computers on the Internet by host name. The DNS server
maintains a database of host hames and | P addresses.

Drop

Allows you to disconnect from an ACD call or non-ACD call. Drop disconnects you from a call
and gives you a dial tone. Use Drop when you want to disconnect from a call and place another
call. You can also use Drop to disconnect the last person added to a conference call.

Dynamic Data Exchange (DDE)
A message protocol in Windows that allows application programs to request and exchange data
between them automatically.

EAS
See|Expert Agent Selection)

Enhanced Conference

Allows you to add parties (up to six) to a call. You select Conference, type the number to be
called into a text box, and click OK. After talking to the party, you can either click Yes to add
the party or No to not add the party to the call. See also |Basic Conference.|

Enhanced Transfer

A transfer option that lets you send the present call to another phone number or extension. You
select Conference, type the number to be called into a text box, and click OK. You are provided
with an “Transfer the party?’ text box in which you can select Yes to transfer the party or No
to not transfer the party. See also[Basic Transfer| and [Unsupervised Transfer.
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Eurofont

A font set provided in DCP terminals that contains characters with diacritical marks common to
other languages. Eurofont includes characters from the Russian, Greek, Baltic Rim, and central
European languages, as well as the first 127 characters of the standard ANSI table. The True
Type Font encoding used for Eurofont is non-standard relative to the encoding used in other
Windows fonts. As a result, IP Agent is able to support Eurofont characters in the displays
received from the DEFINITY ECS.

Expert Agent Selection (EAS)

An optional DEFINITY ECS feature that builds on the power of the Call Vectoring and ACD
features of the DEFINITY ECS to match skills required to handle a particular call to an agent
who has at least one of the skills that a caller requires. Agents are assigned a single set of work
mode buttons, rather than one set per split.

FAC
See Feature Access Code.

Feature Access Code (FAC)

A 1-to-4 digit number with an optional leading * or # that is assigned in DEFINITY ECS
administration to invoke features. For example, *81 may invoke Service Observing Listen Only.
FACs require an available call appearance with dial tone before the FAC can be sent to the
DEFINITY ECS. Assigned FACs may not be available to all users on DEFINITY ECS based on
his/her class of restrictions and/or whether the feature has been enabled in the DEFINITY ECS.

Feature Button

A button placed on the main window that can be assigned to any one of a number of DEFINITY
ECS features that could be assigned to a physical extension’s button during station
administration.

Graphical User Interface (GUI)
This is a picture based, rather than command-line based, interaction between the user and the
computer.

Grayed Out
When you do not have access to a menu or action list item, it will be grayed out (that is,
dimmed or displayed in a different color from the rest of the menu or action list).

GUI
See Graphical User Interface.

Hold
Allows an agent to disconnect from a call temporarily, use the toolbar for other call purposes,
and then return to the original call.
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HTML
See HyperText Markup Language.

Hypertext
A linkage between related text. For example, if you select a word in a sentence, information
about that word is retrieved if it exists, or the next occurrence of the word is found.

HyperText Markup Language
HTML. A standard for defining documents with hypertext links. See also Hypertext.

Installation Folder
A folder on the network that holds all of the IP Agent files. Setup.exe is run from this folder to
install 1P Agent on each computer.

Internet Protocol Address (IP Address)
Each computer has its own unique |P address which is an identifier used for communicating
across a network.

IP Address
See Internet Protocol Address.

Kanafont

A font set provided in DCP terminals that contains Katakana characters (used in Japanese
language) as well as the first 127 characters of the standard ANSI table. The True Type Font
encoding is non-standard relative to the encoding used on other Windows fonts. As a result, 1P
Agent is able to support Katakana characters in displays received from the DEFINITY ECS.

LAN
See Local Area Network.

Local Area Network (LAN)
A private interactive communication network that allows computers to communicate over short
distances at high data transfer rates.

Log
A file that contains a record of computer activity as well as backup and recovery data.

Login

Allows an agent to log into the DEFINITY ECS so that the agent can receive ACD calls.
Non-EAS agents may log in to a maximum of four splits at once. EAS agents can be logged
into as many as 20 skills simultaneously.

Login ID
A login number and that allows an EAS agent to log into agent mode and the skills associated
with that mode on the switch.
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Logout

Allows you to log out of the DEFINITY ECS. When the you out of the DEFINITY ECS, you
cannot receive ACD calls. If you are an EAS agent, you may be requested to enter a reason
code before logging out.

Manual-In

An ACD work mode. In the Manual-In mode, the agent automatically enters the ACW mode
when he or she disconnects from an ACD call. To become available to receive another ACD
call, the agent must manually enter the Auto-In or Manual-In mode.

Network Server
A computer in a network shared by multiple users.

Off-Hook
Off-hook means that the voice path to your telephone is fully functional.

On-Hook
On-hook means that the voice path to your telephone is turned off.

Phone Display

A 40-character display that is located under the Call Information Panel of your CentreVu IP
Agent callbar. This display area receives information from the DEFINITY ECS so that you can
see call and non-call related information, such as call prompting digits and VuStats from the
DEFINITY ECS.

PSTN
See Public Switched Telephone Network.

Public Switched Telephone Network (PSTN)
The worldwide voice telephone network.

RC
See Reason Code.

Readme File
A file that provides the latest information on a newly released product; in this case, CentreVu
IP Agent.

®

Read-only
A folder or file that can be read, but not updated or erased.

Reason Code (RC)
A customer-defined numeric code that describes the reason for entering the AUX work state or
for logging out of the system.
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Registry
The system-wide depository of information supported by Windows. The registry contains
information about the system and its applications, including clients and servers.

Release
Allows you to release an ACD call.

Screen Pop
The ability to automatically display information from other sources, such as databases or Web
pages based on an IP Agent triggering criteria.

Send All Calls
To send all incoming calls (except priority, intercom, and personal central office calls)
immediately to an assigned extension, AUDIX, or message center for coverage.

Senderized Dialing
When a dial string is entered, the Send Digits button or Enter key must be selected to actually
dial the digits. This type of dialing allows for editing of dial strings before sending the digits.

Skill
An attribute that is assigned to an ACD Agent. Agent Skills can be thought of as the ability for
an Agent with a particular set of skills to handle a call that requires one of those skills.

Softphone
A software application that enables you to control telephone calls (both incoming and outgoing)
directly from your computer.

Split
A group of extensions that receives special-purpose calls in an efficient, cost-effective manner.
Normally, calls to a split arrive primarily over one or a few trunk groups.

Stroke Counts

Allows an agent to record the number of times a particular customer-related event occurs. For
example, an agent may be asked to press a button each time a customer requests information
about a particular item. Stroke Count entries are numbered from 1 through 9. Each number is
assigned to a specific item, and the agent enters that number (1-Stroke through 9-Stroke)
whenever a customer asks about that item.

Switch

A private switching system providing voice-only or voice and data communications services
including access to public and private networks) for a group of terminals within a customer’s
premises.
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TAPI Assisted Dialing

IP Agent supports telephony enabled applications such as Microsoft® Scheduler. This support
provides the ability for telephony enabled Windows applications to originate a call and have the
call reflected in the IP agent application.

Toolbar
A row of buttons used to activate various functions of the IP Agent application. The IP Agent
main window can contain as many as five toolbars.

ToolTips
Brief descriptions that display when the mouse pointer is over a toolbar button.

Unsupervised Transfer

A call transfer option that lets an agent send the present call to another phone number or
extension. The agent selects Transfer, types the number to be called into a text box, and clicks
OK to transfer the call. The agent does not talk to the party receiving the transferred call. See
also |Basic Transfer] and |[Enhanced Transfer.|

VDN of Origin Announcement (VOA)
A short announcement that is assigned to a VDN through switch administration. The VOA
identifies the origin or purpose of a call for the call center agent who answers the call.

VOA
See VDN of Origin Announcement.

Voice Terminal

A telephone equipped with specifically designed features (for example, the Conference or Hold
button or Message light) and functional capabilities that distinguish it from a conventional
telephone.

VuStats
Information such as agent, split/skill, VDN, or trunk group data.
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